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Welcome to Final Cut Server

Preface

This chapter covers the following:

« About Final Cut Server (p. 7)

» Resources for Learning About Final Cut Server (p. 9)
« Contacting AppleCare Support (p. 11)

Final Cut Server is powerful media asset management and workflow automation
software. Final Cut Server can manage your assets and refine the processes in your
organization’s workflow, freeing you from the repetitive tasks of managing media and
projects. It can be customized by your Final Cut Server administrator to automate
common tasks. Whether you're running a small production studio or are part of a larger
workgroup, Final Cut Server can streamline your organization’s workflow.

About Final Cut Server

Final Cut Server works similarly to other client-server computer networks. A client
computer sends a request to the server computers. Upon receiving the request, the
server computer performs a job to process the request and then sends the result (or
message of completion of the job) back to the client computer. Jobs can include
uploading, copying, transcoding, cataloging, and otherwise tracking media files. Media
can be stored on the server computer’s internal and external drives as well as on many
supported network devices. Larger facilities may use an Apple Xsan storage area
network (SAN) for asset and production storage.

The Final Cut Server client is the focus of this user manual. The Final Cut Server client is
software that communicates with the Final Cut Server server. The client allows you, one
of multiple users, to access the assets shared across your organization’s system. In your
Final Cut Server client, you can quickly search your organization’s asset catalog and
transfer media files between your local computer and the devices on which the assets
are stored. You can run the Final Cut Server client on Mac OS X v10.4 and Windows XP
or Windows Vista operating systems.




The Final Cut Server client provides many features to help you manage your media.
These features all use Final Cut Server assets. When you upload a media or project file
to Final Cut Server, an asset is created for it. This asset contains metadata, the original
file (called the primary representation file), and proxy copies of the primary
representation file that are used within Final Cut Server.

Final Cut Server can help you do the following tasks:

* Find the assets you need. As the number of assets in your Final Cut Server catalog
increases, creating and managing searches becomes more important.
Final Cut Server provides multiple ways to search and organize the assets in your
organization’s Final Cut Server catalog.

* Have immediate access to media. Final Cut Server provides immediate access to media
from the Final Cut Server client software. You can easily get information and view a
media asset from the client software. If you want to edit the media asset, you can
check out a Final Cut Server-managed copy of the file to your local computer, edit it,
and then check it back in to Final Cut Server. Because Final Cut Server is managing
the checked out file, the new edits are tracked by Final Cut Server.

« Track the status of media. Final Cut Server provides metadata fields and saved
searches to help you track assets as they move through your organization’s workflow.
Your Final Cut Server administrator can further customize the metadata fields to
increase the effectiveness of asset tracking for your organization.

* Perform powerful media conversion. Final Cut Server uses Compressor, a powerful
transcoding application that is part of Final Cut Studio, to convert media from one
video format to another when uploading, exporting, and copying media files.

» Work while not connected to the Final Cut Server network.You can check out
Final Cut Server-managed project and media files and then edit them while not
connected to the Final Cut Server network. When you later connect to the
Final Cut Server network, you can check the edited files back in to Final Cut Server.
When you check in the files, the assets that track the files are updated with the new files.

This user manual covers what users can do with the Final Cut Server client. For
information about administering and customizing Final Cut Server, read the

Final Cut Server Setup and Administration Guide, a document written for Final Cut Server
system administrators.

Preface Welcome to Final Cut Server



Resources for Learning About Final Cut Server
There are a variety of resources for you to use when learning about your
Final Cut Server system.

Final Cut Server Printed Documentation

This guide is one of two printed documents that are included with Final Cut Server.

* Final Cut Server User Manual: This user manual describes how to use the
Final Cut Server client for the day-to-day use of the system, such as browsing assets,
managing jobs, and managing productions.

* Final Cut Server Setup and Administration Guide: This guide describes how to install,
configure, and administer most components of the Final Cut Server system. It does
not describe day-to-day use of the system, such as browsing assets and managing
jobs, productions, and orders, which are described in the Final Cut Server User Manual.

Final Cut Server Onscreen Manual
An onscreen version of the Final Cut Server User Manual is available for all users from the
client’s Help menu.

The content of the onscreen versions of this documentation is identical to the printed

version. The onscreen version, however, is fully hyperlinked and enhanced with many

features that make locating information quick and easy:

» The access page provides quick access to various features, including the index and
other relevant documents and websites.

» A comprehensive bookmark list allows you to quickly choose what you want to see
and takes you there as soon as you click the link.

In addition to these navigational tools, the onscreen document gives you other means
to locate information quickly:

« All cross-references in the text are linked. You can click any cross-reference and jump
immediately to that location. Then, you can use the Preview Back button to return to
where you were before you clicked the cross-reference.

 The table of contents and index are also linked. If you click an entry in either of these
sections, you jump directly to that section of the document.

» You can search the text for specific words or phrases.

Preface Welcome to Final Cut Server
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Apple Websites
There are a variety of Apple websites that you can visit to find additional information.

Final Cut Server Website
Go here for general information and updates as well as the latest news on
Final Cut Server.

To access the Final Cut Server website, go to:
* http://www.apple.com/finalcutserver

There are also a variety of discussion boards, forums, and educational resources related
to Final Cut Server on the web.

Apple Service and Support Website

Go here for software updates and answers to the most frequently asked questions for all
Apple products, including Final Cut Server. You'll also have access to product specifications,
reference documentation, and Apple and third-party product technical articles.

To access the Apple Service and Support webpage, go to:
« http://www.apple.com/support

To access the Final Cut Server support page, go to:
* http://www.apple.com/support/finalcutserver

To access the Apple discussion pages, go to:
« http://discussions.info.apple.com

Preface Welcome to Final Cut Server
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Contacting AppleCare Support
Information about the support options available from Apple is included in your
Final Cut Server box. Several levels of support are available.

Whatever your issue, it's a good idea to have the following information immediately

available when you contact Apple for support. The more of this information you have

to give to the support agents, the faster they will be able to address your issue.

« The Final Cut Server Support ID number found on the front of the serial number
sheet included in your Final Cut Server box.

Note: The 11-digit Support ID number is different from the product serial number
used to install Final Cut Server.

» The version of Leopard or Leopard Server you have installed. To find the version,
choose Apple menu > About This Mac.

« The version of Final Cut Server you have installed that you have a question about. To
find the version of Final Cut Server on your computer, choose Final Cut Server >
About Final Cut Server.

« The model of computer you are using.

» The amount of RAM installed in your computer. You can determine this by choosing
Apple menu > About This Mac.

» What other third-party hardware is connected to or installed in the computer, and
who the manufacturers are. Include hard drives, graphics cards, and so on.

To access AppleCare Support for Final Cut Server, go to:
* http://www.apple.com/support/finalcutserver

There is also an item in each Final Cut Server client’s Help menu that will take you
directly to the AppleCare website.

To go to the AppleCare website from within a Final Cut Server client:

= Choose Help > Final Cut Server Support.

Preface Welcome to Final Cut Server
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About Final Cut Server

This chapter covers the following:

« The Final Cut Server Client Workflow (p. 14)

« Installing the Final Cut Server Client (p. 15)

« The Final Cut Server Main Window (p. 15)

» Views for Assets and Productions Panes (p. 17)

« Search Options and Saved Searches (p. 20)

+ Asset Info Window (p. 21)

« Final Cut Pro Project Info Window (p. 22)

« Final Cut Studio Project Info Window (p. 22)

« Production Info Window (p. 23)

e Annotations Window (p. 24)

« Downloads & Uploads Window (p. 25)

« Search All Jobs Window (p. 25)

« Search Devices Window (p. 26)

+ Preferences Window (p. 27)

« Using Shortcut Menus in Final Cut Server (p. 28)
» Using Keyboard Shortcuts in Final Cut Server (p. 28)

This chapter provides an overview of the Final Cut Server client, including information
about the Final Cut Server workflow, how to install the Final Cut Server client, and
descriptions of the Final Cut Server user interface. You can use this chapter to orient
yourself while learning to use Final Cut Server. You'll find more information about the
features described in this chapter in the following chapters.
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The Final Cut Server Client Workflow

Final Cut Server makes it easy for users to find, access, and track media and project files,
as well as transcode media and easily check in and check out assets for editing.

While different organizations perform each of these tasks slightly differently, the typical
Final Cut Server workflow involves four steps.

Step 1: Organize existing media and upload new media

The project you're working on might use media that has already been uploaded to
Final Cut Server, or it may require new media. Media can be uploaded using an
automated scan set up by your administrator or uploaded manually by any person in
your organization.

Step 2: Edit the media and project

This step of editing within your organization can include creating and editing a

Final Cut Pro project, creating and revising artwork and graphic overlays or motion
effects, or other workflows your organization uses to create projects for client review.
The final part of this step involves putting all the finished pieces together into a review
copy of the project.

Step 3: Review and approve the project

This step may involve your coworkers or clients logging into Final Cut Server and
viewing the project or sending copies of the project out for review. If your

Final Cut Server administrator has configured your system to automatically send out
Review and Approve emails, they are used in this step.

Step 4: Output and archive the final media and project
This step includes creating backup copies of the assets and archiving the final assets in
Final Cut Server.

Final Cut Server can be customized to meet the specific needs of your organization’s
workflow. For more information, contact your Final Cut Server administrator.

Chapter 1 About Final Cut Server



The Server pop-up menu

The Window pop-up —

menu

The Assets and
Productions panes each
has a Toolbar.

Click this button to
show or hide the
Information pane.

Installing the Final Cut Server Client

Your Final Cut Server administrator will provide you with a URL from which you can
download a copy of the Final Cut Server client to your computer. Your administrator
will also give you a user name and password for the Final Cut Server client.

After downloading the Final Cut Server client, a login screen appears. You can log in
to Final Cut Server using the user name and password provided by your
Final Cut Server administrator.

You can log out of the Final Cut Server client by choosing Log Out from the Server
pop-up menu, or by clicking the close button in the Final Cut Server main window.

After the Final Cut Server client is installed on your computer, you can open it by
double-clicking the application icon that appears in the location where you installed
the application.

The Final Cut Server Main Window

After logging in to Final Cut Server, you'll see the Assets pane of the Final Cut Server main
window. The Assets pane may be empty or filled with media that has been scanned by
your Final Cut Server administrator or uploaded by other Final Cut Server users.

Note: The screen shots shown in this manual show a default Final Cut Server system.
Because your Final Cut Server administrator can configure different media types and

metadata fields, your system may look different than the system shown on these pages.

The Help pop-up menu

Click this button to open
the Downloads &
Uploads window.

Chapter 1 About Final Cut Server
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The Lock button

Click Assets to see the
Assets pane.

The Information pane
shows information about
any jobs that are in
progress.

The Assets pane and Productions pane are the two views of the Final Cut Server main
window. An asset is used by Final Cut Server to track every file that is uploaded to the
server or scanned. The Assets pane shows all the assets that Final Cut Server is
managing. Productions are used to group assets. The Productions pane shows all the
productions that have been created by you or other people who use your

Final Cut Server system.

You switch between the Assets and Productions panes by clicking either Assets or
Productions at the top left of the Final Cut Server main window.

Assets Pane

After clicking Assets, all of the assets that exist in Final Cut Server are listed in the main
part of the window. You can move through the assets by clicking the page controls in
the top-right corner of the Assets pane. The Toolbar includes the Lock button, the
Check Out button, and the New Production from Selection button. After selecting an
asset, these buttons become active.

Move through multiple
The Check Out ~ The New Production pages of assets using
button

from Selection button these controls.

Final Cut Secvrr. tamitmadisterves apple cam

— Assets are
here.

To learn more about media assets, see Chapter 5,”Working with Media Assets,” on
page 103.To learn more about Final Cut Pro project assets, see Chapter 6,“Working
with Final Cut Pro Projects,” on page 113.To learn more about Final Cut Studio project
assets, see Chapter 7,“Working with Final Cut Studio Projects,” on page 129.
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Click Productions to see
the Productions pane.

Productions Pane
The Productions pane varies somewhat from the Assets pane. Its Toolbar has a New
Production button.

The Production Toolbar has
a New Production button.

- Productions
are shown
here.

To learn more about productions, see “Organizing Assets with Productions” on page 54.

Views for Assets and Productions Panes
The Assets and Productions panes can be displayed as lists or thumbnails. You can
change the view by clicking the List View button or Thumbnail View button.

»Q  Contains (more

—— Thumbnail View button
B Assers 4 — List View button

E Productions
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Thumbnail View

Thumbnail view displays a thumbnail image of the asset. The thumbnail image can be
a frame from the video file that was uploaded, the graphics or image file that was
uploaded, or an icon representing the type of asset or application the asset was
created in. Thumbnail view is useful when you want to browse a number of assets or
productions in a compact format without other information.

This Final Cut Pro project
asset is represented with
Thumbnail view selected a Final Cut Pro icon.

This video asset is —
represented with a
thumbnail image.

List View
List view displays the asset Title and other metadata in columns. This view is useful
when you want to view asset or production information or sort by any field.

List view selected
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Final Cut Server marks assets and productions with icons to identify them. In
Thumbnail view, the icons appear on the asset or production tile, just above the
thumbnail image or icon. In List view, the icons appear to the left of the Title column
and in the State column.

The icons you'll see on assets and productions include:

Icon Description

Final Cut Pro project asset

Media (video) asset

Media (graphic or still image) asset

Media (audio) asset

Asset (generic) or bundle asset

Asset checked out by me

Asset checked out by another user

Asset locked by me

Asset locked by another user

=

Asset archived (yellow) indicates you can restore this asset from its
archive

Asset archived (white) indicates you do not have permission to
restore the asset from its archive

Unlinked Final Cut Pro project element

Primary representation for this asset is missing from its device

Final Cut Server cache is out of date

HHEEEIIEI*-IHEEEE

For specific information about these icons, see the chapter that describes the type of
asset or the state that the icon describes.

Chapter 1 About Final Cut Server
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Asset and production
Smart Searches are
saved here.

Search Options and Saved Searches

A search field is at the top of the Assets and Productions panes. You can use this search
field to find a specific asset or production, or to limit the number of assets or
productions shown.

Close the disclosure
triangle to show only the
simple search settings.

Talala Final Cut Sarver: rom

Clicking the search disclosure triangle reveals advanced searching options. The Assets
and Productions panes have different advanced search options.

Open the disclosure
triangle to show the
advanced search settings.

A Fimal Cut Serves. m

When you create searches that you will repeat, you can save the search so you can use it
in the future. Final Cut Pro comes with several default saved searches, called Smart
Searches, which are stored in the column on the left of the main Final Cut Server window.

0606

Assets

roductions

For more information on searching, see Chapter 3,”Organizing and Searching
the Final Cut Server Catalog,” on page 49.
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The asset’s thumbnail —
image and general
asset metadata

Asset Info Window

The info window contains a large amount of information about the asset. When you
double-click an asset that is listed in the Assets pane or in a production (or Control-click
an asset and then choose Get Info from the asset’s shortcut menu), the asset’s info
window appears.

The left side of the asset info window displays the asset’s thumbnail image and general
asset metadata. The right side of the asset is organized into multiple panes that list
specific types of information. You can view the information in each pane by clicking the
pane’s button.

Click the Metadata
button to display the
metadata pane.

ann 3136_00-Camara D-Color

- The Metadata pane

» Metadata pane: This pane lists metadata for the primary representation file (the file
that was originally uploaded to Final Cut Server) and metadata for the asset.

* Resources pane: This pane lists information about the primary representation and
proxy files that were generated for the asset. It also displays other information about
where the asset is used.

 Versions pane: This pane lists information about versions of the asset that have
been saved.

 Locks pane: This pane lists locks that have been applied to the asset.

« Review & Approve pane: This pane shows the asset’s status and is used for the Email
Notification feature.

For more information about the Metadata, Resources, Versions, and Locks pane, see
“About the Asset Info Window” on page 79. For more information about the Review &
Approve pane, see “About the Review and Approve Feature” on page 146.

Chapter 1 About Final Cut Server
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Final Cut Pro Project Info Window
You can view a Final Cut Pro project’s info window by double-clicking a Final Cut Pro
project asset (or Control-click the asset, then choose Get Info from the shortcut menu).

When Final Cut Pro projects are uploaded to Final Cut Server, an asset is created for the
project file. In addition to the panes included in the asset info window, the

Final Cut Pro project asset info window includes an Elements pane. This pane lists the
media assets that are used in the Final Cut Pro project file.

Click Elements to view
the Elements pane.

nnn 3133 Motorbiken.

- The Elements pane lists
the media that is used in
the Final Cut Pro project.

For more information about Final Cut Pro project assets, see Chapter 6,“Working with
Final Cut Pro Projects,” on page 113.

Final Cut Studio Project Info Window

You can view a Motion, Soundtrack Pro, or DVD Studio Pro project asset’s info window
by double-clicking a Final Cut Pro project asset (or Control-click the asset, then choose
Get Info from the shortcut menu).

When Final Cut Studio project files are uploaded to Final Cut Server, the asset that is
created for the Final Cut Studio project represents only the project file. Unlike

Final Cut Pro project assets, the Final Cut Studio project asset does not contain a list of
the media linked to the project.

Chapter 1 About Final Cut Server



A Final Cut Studio project asset info window includes Metadata, Resources, Versions,
Locks, and Review & Approve panes. You can view the information in each pane by
clicking the pane’s button.

For more information about Final Cut Studio project assets, see Chapter 7,"Working
with Final Cut Studio Projects,” on page 129.

Production Info Window

In Final Cut Server, you can use productions to group related assets. If you click to open
the Productions pane at the top left of the Final Cut Server main window and then
double-click one of the productions (or Control-click the production, then choose Get
Info from the shortcut menu), that production’s info window is displayed.

The Assets pane shows all of the assets contained in the production; the Metadata
pane shows the production’s metadata.

~en Matarbikes L

— You can click either of
these buttons to display
more information about
the production.

— Each of these assets is
part of the production.

To learn more about productions, see “Organizing Assets with Productions” on page 54.

Chapter 1 About Final Cut Server
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You can preview the —
clip here.

You can add text in the — 2

Annotation field.

Annotations Window

You can mark a single video asset with comments in the Annotations window. Because
comments added in the Annotations window stay with the video asset in

Final Cut Server, annotations are useful for internal reviews and communication with
other Final Cut Server users.

To view the Annotations window, open a video asset’s info window and click the
Annotations button.

—— Click the Annotations
button in a video asset’s
info pane to open the
Annotations window.

Annotations that have
been added to a video
asset appear here.
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Downloads & Uploads Window
This window helps you more closely monitor the status of files that you are uploading
to or downloading from Final Cut Server.

You can open the Downloads & Uploads window by clicking the Downloads and
Uploads button in the Final Cut Server main window (or by choosing Downloads &
Uploads from the Window pop-up menu).

For more information about the Downloads & Uploads window, see “The Downloads &
Uploads Window” on page 98.

Search All Jobs Window

The Search All Jobs window is opened from the Server pop-up menu (located at the
top-left corner of the Final Cut Server main window). It shows a list of recent jobs that
were initiated by all Final Cut Server users.

B _Search Al Jobs

The Search All Jobs
window shows a list of
the most recent jobs
initiated by all Final Cut
Sever users.

For more information about the Search All Jobs window, see “Searching for a Job” on
page 74.
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Search Devices Window

The Search Devices window is opened from the Server pop-up menu in the

Final Cut Server main window. In it, you can search a device directly, viewing all the
assets (files that have been uploaded to Final Cut Server) as well as other files that have
not been uploaded to Final Cut Server and are stored on the device.

Warning: Use the Search Devices window with caution. Devices can contain files that
both have and have not been added to the Final Cut Server catalog. Working with
files in the Search Devices window could result in making duplicate copies of an asset
in your Final Cut Server server system, or in deleting all copies of a file from a device.

For more information about the Search Devices window, see “Searching Devices” on
page 72.
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Preferences Window

Your Final Cut Server administrator is responsible for configuring most of the
preferences that affect you while working with your Final Cut Server client. However,
there are a few settings that you specify for your Final Cut Server client. These include
search display preferences, the location and size of the Final Cut Server cache, and the
location to which you can save alias copies of prepared media files.

You can open the Preferences window by choosing Preferences from the Server
pop-up window.

A Preferences for mediaserverapple.cam

For more information about the preferences for your Final Cut Server client, see
“Setting Final Cut Server Client Preferences” on page 100.
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Using Shortcut Menus in Final Cut Server

You can take many actions in Final Cut Server by making choices from shortcut menus.
You can view a shortcut menu’s items by Control-clicking an asset, a Final Cut Pro
project, or another area of Final Cut Server.

—— The asset shortcut menu

Mac users using a multi-button mouse can also use right-click to access shortcut menus.

Note: If you're a Windows user, note that a right-click on a Windows system is the
equivalent of a Control-click on a Mac. To display the shortcut menu on your Windows
system, right-click.

Using Keyboard Shortcuts in Final Cut Server

Many of the standard Mac OS X keyboard shortcuts are available in Final Cut Server. In
addition, application-specific keyboard shortcuts are available for the Final Cut Server
Annotations window.
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Uploading Files to Final Cut Server

This chapter covers the following:

» About Creating Final Cut Server Assets (p. 29)

* Types of Files That Can Be Uploaded to Final Cut Server (p. 30)
« About Metadata and Metadata Sets (p. 30)

« Strategies for Uploading Media and Project Files (p. 31)

» Uploading Media Files (p. 32)

» Uploading Final Cut Pro Projects (p. 37)

» Uploading Final Cut Studio Projects (p. 40)

Before you can manage and track your files in Final Cut Server, you first need to upload
the files. This chapter describes how to upload three different types of files to

Final Cut Server: media files, Final Cut Pro project files, and Final Cut Studio projects
and their linked media files.

About Creating Final Cut Server Assets

The first step in building a Final Cut Server asset catalog is to upload media to

Final Cut Server. You can manually upload media files, Final Cut Pro projects, and other
Final Cut Studio project files to Final Cut Server. Additionally, your Final Cut Server
administrator can set up automated processes to automatically upload files. Even if
your Final Cut Server administrator has created useful automated upload workflows,
you will often manually upload files to Final Cut Server.

When a file is uploaded to Final Cut Server, an asset is created. The asset is used by
Final Cut Server to track the media or project file that you uploaded. The asset contains
the original file and the metadata from the file. Depending on the type of file that has
been uploaded, the asset may also contain several proxy files, including a Clip Proxy
(for video files) and a Thumbnail and Poster frame proxy (for all media files). More
information about proxy files is included later in this chapter.

Because media assets, Final Cut Pro project assets, and Final Cut Studio (Motion,
Soundtrack Pro, and DVD Studio Pro) project assets are managed differently in

Final Cut Server, how to work with each type of asset is explained throughout this manual.
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Types of Files That Can Be Uploaded to Final Cut Server

Final Cut Server can manage many types of files, including the following:

Media Category Supported File Types

Video Final Cut Pro projects (.fcp) and many of the video file formats
available for output from Final Cut Pro and Compressor, including
.mov and .mpeg

You can also upload QuickTime reference movies.

Audio Soundtrack Pro files (.stap and .stmp) and other audio files, including
.aif, .ac3, uncompressed audio files, . mp3, .mp4, .m4a, and .wav

Motion graphics Motion projects (.motn)

DVD DVD Studio Pro project files (.dspproj), iDVD (.dvdproj) projects

Still images and graphics Photoshop files (.psd) and other graphic and image files including

tif, jpeg, .png, .bomp, and .gif

Text files Pages files (.pages), Keynote files (key), and other document files
including .doc, .txt, and .pdf

About Metadata and Metadata Sets

Metadata is an important part of the assets and productions included in the

Final Cut Server catalog. Because you search for asset and production metadata, it is
important that you add as much metadata as possible when you are uploading the
original file.

When you upload a media or project file, all the supported metadata contained in the
file is uploaded with the file and applied as file metadata in Final Cut Server. The
Upload window also prompts you to provide a metadata set. A metadata set is a
collection of metadata groups and fields. The metadata set that you choose for the
asset determines what metadata can be added to the asset.

Note: Common metadata, including XMP and QuickTime, is supported by Final Cut Server.
If you have specific questions about the metadata supported by Final Cut Server, contact
your Final Cut Server administrator.
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Final Cut Server comes with default metadata sets to describe your assets. If the default
metadata sets do not meet the needs of your organization’s workflow, your

Final Cut Server administrator can add metadata fields to existing sets or create entirely
new metadata sets.

Important: If your Final Cut Server administrator has modified the default metadata
sets or created new ones, the metadata sets listed in your copy of Final Cut Server will
look different than the list shown here.

When you're working in Final Cut Server, you can use the metadata that an asset
contains to search for, sort, and identify assets and productions in Final Cut Server, and
to track information within your workgroup. After a file is uploaded, you and others can
manually add and change the metadata that describes the asset at any time.

For more information on how to use metadata in Final Cut Server, see “Using Metadata
to Organize and Search Assets”on page 58.

Strategies for Uploading Media and Project Files

Your Final Cut Server administrator may have set up scans that automatically upload

files to Final Cut Server. When you want to upload media and project files manually,

you can do it in two ways:

* You can drag files from your system or a connected device to Final Cut Server. This is
the option to use when you have a few pieces of media you want to add to your
asset catalog.

* You can open the Upload window from the Server pop-up menu in the
Final Cut Server main window, navigate to a folder of media files, and then select the

ones to be uploaded. This is the option to use if you are uploading multiple media files.

Important: It is recommended that you include file extensions on all files uploaded to
Final Cut Server.

Chapter 2 Uploading Files to Final Cut Server
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In the Upload window that appears, you have many options. You can choose a
metadata set for the new asset. You should also add several types of metadata to the
file at upload.

You can also choose to convert the file being uploaded to another codec (using the
transcode settings for video and audio files from Compressor) during upload, and
group the asset in a production.

When you upload a file, the filename is entered, by default, in the Title field in the
Upload window. You can choose to enter a new name in the Title field; however, it is
important to understand that the Title field is used exclusively in Final Cut Server.The
asset’s title will not appear in the asset’s metadata if you export a copy of the asset.

Important: If you are uploading large project or media files, turn off your computer’s
sleep function. If the computer on which the Final Cut Server client is running goes to
sleep during an upload, the upload will be canceled.

About Uploading QuickTime Reference Movies

A QuickTime reference movie can contain a list of references to movies having different
data rates, allowing an application to choose the best-looking movie that can play
smoothly as it downloads over the Internet, based on the user’s connection speed.
When you upload a QuickTime reference movie, a dialog appears advising you that the
movie has one or more external alias files and asking you if you want to flatten the file
before uploading it. Flattening the file creates a new file that contains all of the media
that was previously in the external alias file or files. It is recommended that you choose
to flatten any QuickTime reference movies that you upload to Final Cut Server.

Uploading Media Files
When you upload a media or project file to Final Cut Server, the asset that is created
contains the original media file, which Final Cut Server calls the primary representation.

At upload, Final Cut Server creates proxy files for certain types of media assets. Proxy
files are copies of the primary representation that are used for certain operations within
Final Cut Server.

If the file being uploaded is a graphics or video file, Final Cut Server creates two proxy
graphics files: a Poster frame and a Thumbnail. These are used to represent the asset’s
media within Final Cut Server.

If the file being uploaded is a video asset, Final Cut Server also creates a Clip Proxy file.
The Clip Proxy file is created by transcoding the primary representation file to a
lower-resolution codec. The Clip Proxy is used for viewing the file in Final Cut Server.
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Here’s an example. When you upload an uncompressed HD video clip to

Final Cut Server, a Final Cut Server asset is created. This asset holds the original file (the
primary representation). The original file is also transcoded to create the Clip Proxy file,
and JPEG images are created to be used as Thumbnail and Poster frame proxy files for

the asset.

Upload video clip to Final Cut Server

Media asset
Clip Proxy

Primary
representation

| Metadata |

Thumbnail

Poster frame |

Media file

After the upload is complete, you can view a list of the proxy files created for the asset
in the Resources pane of the asset’s info window.

You can see proxy files
created for the asset in
the Resources pane of
the asset info window.

You can upload one or more media files to Final Cut Server. When you upload multiple
media files, keep in mind that any setting you define in the Multiple Upload window,
including metadata, will apply to all the files being uploaded. For example, if you
specify a transcode format, all of the files being uploaded will be transcoded.

Important: It is recommended that you include file extensions on all files uploaded to
Final Cut Server.
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To upload one or more media files:
1 Do one of the following:

 Drag the media file or files that you want to upload from the Finder, the desktop, or a
connected volume to the column on the left of the Final Cut Server main window,
the Assets pane, or a production.

» Choose Upload File from the Server pop-up menu, select the media file or files in the
file browser that appears, then click Upload.

The Server pop-up menu

Depending on the number of files you uploaded, the Upload or Multiple Upload
window appears.

el Upload.

The Upload window
includes an editable
Filename field.

Advaneed Oprinns

The Upload and Multiple Upload windows are very similar. In the Upload window, you
can enter a filename for the asset (the filename is entered automatically). In the
Multiple Upload window, the filename field is hidden, and each asset being uploaded is
automatically named with the filename.

Note: You can change an asset’s title at any time after uploading in the asset’s info
window Metadata pane.
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2 Some of the information and metadata in the Upload or Upload Multiple window is
automatically entered. You can change the metadata set from the Metadata set pop-up
menu and add metadata for the new asset or assets.

A Multiple Uploas

Choose a different
metadata set from the
pop-up menu. —;

After choosing a
metadata set, a variety of
metadata groups appear.

I_I_l

You can enter metadata
in any editable field.

Important: If you are uploading a file that you previously added metadata to using the
default QuickTime annotation fields, you must choose the Media metadata set for the
asset. When you do this, the metadata that was assigned to the file in QuickTime
appears in Final Cut Server in the QuickTime metadata group of the Media metadata
set. If you apply any other metadata set to the asset, the QuickTime metadata will not
appear in the Final Cut Server asset.

Remember that all the metadata you apply for a multiple upload will be attached to
each of the assets being created.

3 If necessary, choose a new destination device from the Destination pop-up menu. This
specifies the device on which the file will be stored. If you have questions about which
device to choose, contact your Final Cut Server administrator.

To group the assets in a
production, click Choose
and select a production.

A Multiple Uploas

The Destination
pop-up menu

To transcode the media
files, click Choose and
select a codec.

When you're ready to
upload the files, click
d Begin Upload.
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Click “Assets created by
me” to view the asset
that was created.
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Note: Media and Library are the primary Final Cut Server devices. Talk with your
Final Cut Server administrator about which other configured devices are appropriate
for media file storage.

If you want to group the media asset or assets in a production, click Choose at the right
of the Associate with Production field and specify a production.

For more information about productions, see “Organizing Assets with Productions”on
page 54.

If you want to convert the original media file or files to a different codec, click the
Choose button and then select a new transcode setting in the window that appears.
Click Begin Upload to create assets from the media file or files.

The upload begins. The upload progress is displayed above the Information pane in the
bottom-left corner of the Final Cut Server main window.

Jobs in Progress 3 —— The Jobs in Progress
® % indicator shows how

! many jobs are being run.

Click this button to
open the Downloads
& Uploads window.

To monitor the progress of the file upload, click the Downloads and Uploads button to
display the Downloads & Uploads window.

After the file is uploaded, click the “Assets created by me” Smart Search to view the new
asset or assets that you just uploaded.
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Uploading Final Cut Pro Projects

Final Cut Pro project assets have a different structure than media assets. When you
upload a Final Cut Pro project to Final Cut Server, the Final Cut Pro project file is the
primary representation for the asset. Final Cut Server discovers the video and other
media files that are linked to the Final Cut Pro project and uploads each of the media
files as a unique media asset. Final Cut Server then lists each of the project’s linked
media files as an element of the Final Cut Pro project.

Note: If your Final Cut Server administrator has turned on Edit Proxy file creation, an Edit
Proxy will also be created for every video file that is linked to the Final Cut Pro project.
This Edit Proxy is used for checking out Final Cut Pro projects for editing. For more
information about the Edit Proxy feature, talk to your Final Cut Server administrator.

The illustration below shows a Final Cut Pro project at upload. Notice that the elements
list is inside the asset, but the media assets that the elements list references are
independent media assets. Any of the media assets can be found by double-clicking the
element in the Elements pane; when you do this, the media asset’s info window opens.

Upload Final Cut Pro Project to Final Cut Server

i

Final Cut Pro project Project asset

List of linked
media elements

Clip Proxy

Chapter 2 Uploading Files to Final Cut Server
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After a Final Cut Pro project has been uploaded, you can get information about the
project’s linked media files in the Elements pane of the Final Cut Pro project’s asset
info window.

The linked media is
shown in the asset info

window’s Elements pane.
nnn MLNM

Alternately, you can look at the Resources pane of a media asset’s info window to see if
a media asset is linked to a Final Cut Pro project.

An instance of this media
asset is used in the

Final Cut Pro project
titled “3133_Motorbikes.”

The production
“Motorbikes1” includes
this media file.

Important: It is recommended that you include file extensions on all files uploaded to
Final Cut Server.
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To upload a Final Cut Pro project file:
1 Do one of the following:

« Drag the Final Cut Pro project file to the column on the left of the Final Cut Server
main window, to the Assets pane, or to a production in the Productions pane.

» Choose Upload File from the Server pop-up menu (the pop-up menu in the
Final Cut Server main window that appears when you click the Server button), select
the Final Cut Pro project file in the file browser that appears, then click Upload.

The Upload Final Cut Pro Project window appears.

AL Upload Final Cut Pro Project

2 Some of the information in the Link Final Cut Pro Upload window is automatically
entered. You can change the metadata set and add any metadata for the new
Final Cut Pro project and the linked media.

Important: Any metadata you enter for the project asset will be applied to the new
project asset and to each asset being created for the linked media files.

3 If necessary, choose a new destination device from the Destination pop-up menu.

This specifies the device on which the file will be stored. If you have questions about
which device to choose, contact your Final Cut Server administrator.

Note: Media and Library are the primary Final Cut Server devices. Talk with your
Final Cut Server administrator about which other configured devices are appropriate
for media file storage.

Chapter 2 Uploading Files to Final Cut Server
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4 If you want to group the Final Cut Pro project asset in a production, click Choose at the
right of the Associate with Production field and specify a production.

For more information about productions, including creating a new production, see
“Organizing Assets with Productions” on page 54.

5 Click Upload.

The upload begins. The upload progress is displayed above the Information pane in the
bottom-left corner of the Final Cut Server main window.

6 To monitor the progress of the file upload, click the Downloads and Uploads button to
display the Downloads & Uploads window.

7 After the file is uploaded, click the “Assets created by me” Smart Search to view the new
asset or assets that you just uploaded.

Uploading Final Cut Studio Projects

Final Cut Pro project assets are unique in that the relationship between a Final Cut Pro
project and its linked media files is managed by Final Cut Server. Final Cut Studio
project files can also be uploaded as assets and tracked by Final Cut Server, but the
references between the project file and the media files are not automatically managed
by Final Cut Server.

It is recommended that you upload a folder containing the Final Cut Studio project file
and all of the media files linked to the project to Final Cut Server.

Important: It is possible to upload only a Motion, Soundtrack Pro, or DVD Studio Pro
project file to Final Cut Server. When you upload only the project file, an asset will be
created for only the project file. Unlike a Final Cut Pro project file, the Final Cut Studio
project file will not include a list of elements. Instead of uploading a single project file,
it is recommended that you upload a folder containing the Motion, Soundtrack Pro, or
DVD Studio Pro project file and all of the media files linked to the project file to

Final Cut Server.

When you upload a folder containing the Motion, Soundtrack Pro, or DVD Studio Pro
project file and all of the media files linked to the project file, a dialog appears asking
you if you want to the upload the folder and the files it contains as a bundle asset or as
individual assets.
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If you select Create Bundle Asset, the project file and each of the media files are
uploaded as a bundle asset. Uploading the folder as a bundle asset guarantees that
when you check out or export the bundle asset, all of the media files that were
checked in with the project will still be there. The bundle asset can be checked out,
edited, and checked back in; it can also be exported. However, when you upload a
folder of files as a bundle asset, the files that the bundle asset contains are not available
as separate assets in Final Cut Server.

If you select Create Individual Assets, the project file and each of its linked media files
are uploaded to Final Cut Server as single and unique assets. Because Final Cut Server
does not manage the references between the project and media files, it is advised that
you group the project asset and media assets in their own production, and that you
add unique metadata to the project asset and media assets. You can perform both
these tasks in the Upload window that appears after selecting Create Individual Assets.
While uploading a folder of files as individual assets requires some planning, it is useful
because each of files in the folder is uploaded as an individual asset and can be
accessed from within Final Cut Server.

Important: It is recommended that you include file extensions on all files uploaded to
Final Cut Server.

Uploading a Final Cut Studio Project and Its Media Files

as a Bundle Asset

Choosing to upload a Final Cut Studio project and its media files as a bundle asset
creates a single asset in Final Cut Server. This bundle asset is easy to work with: after
checking out or exporting the bundle asset, the folder becomes visible and you can
open the project file contained in the folder in the appropriate Final Cut Studio
application. Assuming that the media was linked to the project file when the folder was
uploaded to Final Cut Server, the project file will open with all its media connected and
ready to use.

Chapter 2 Uploading Files to Final Cut Server
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The illustration below shows a Final Cut Studio project being uploaded as a bundle
asset. The bundle asset appears in Final Cut Studio as a single generic asset, with no
indication of its project file or its linked media files.

Upload folder to Final Cut Server

/  Folder \
/

Project

Bundle Asset

( 5 - -

&

BikeBlur.motn Music_3225.aif Motorbikes.aif
(] S e 4

Road_3232.mov  Rider_322jpg  Quill_5344.jpg

If you upload a Final Cut Studio project and its media files as a bundle asset, the media
and project files are not available to be viewed from within Final Cut Server.To access
the media assets, you must check out the bundle asset and access the media files from
inside the folder.

Important: If a Final Cut Studio project and its media files are uploaded as a bundle
asset to a device that has been automated by your Final Cut Server administrator to
scan for new assets, the files in the bundle asset will be analyzed and new assets will be
created for each file in the bundle. If you upload a Final Cut Studio project and its
media files as a bundle asset and then notice new assets have been created for the files
in the bundle, contact your Final Cut Server administrator.
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To upload a Final Cut Studio project file and its media files as a bundle asset:

In the Final Cut Studio application, save the project and choose to collect the media. In
Motion and Soundtrack Pro, you can do this by choosing File > Save As and choosing
to collect the media in the Save As window. In DVD Studio Pro, you need to manually
place the project and media files in a folder.

Note: For specific information on using these applications, see the application’s
User Manual.

Important: When uploading a DVD Studio Pro project file and its linked media files,
there is no need to upload .par files. When you check out and open the project in
DVD Studio Pro, the .par files will be automatically recreated.

The project file and its media files are saved in a folder at the location you specified.

Name
v [ MotorbikeBlur_motion
v [ Media
B Motorbikes.aif
[8] Music3225.aif

quill_5344.jpg . . )
% rider 322.jpeg The Motlon project’s
B road_3232.mov media files

|—£| Wreckimpact.aif
¥ [ MotorbikeBlur3_moticn
7] MotorbikeBlur3.motn

A Motion project

In Final Cut Server, create a new production for the project and its assets by following
these steps:

a Open the Productions pane by clicking Productions in the column at the left of the
main Final Cut Server window.

b Click the New Production button in the Toolbar.

¢ Choose a metadata set for the new production from the Metadata Set pop-up menu.

d Depending on the production type you chose, a number of production metadata
fields appear. Enter a title and other unique metadata for the project in these fields.
Fields marked with an asterisk (¥) must be filled in.

e Click Save Changes to save the new production.

Drag the folder that contains the project file and its linked media from the Finder to
the new production in the Final Cut Server Productions pane.
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4 A dialog appears, asking you if you want to upload the folder as a bundle asset or as
individual assets. Click Create Bundle Asset.

The Link Upload window appears. Note that the Associate with Production field shows
the production that you dragged the folder to.

Tt Link Uplaad

The name of the
production that you
dragged the folder to
appears here.

Add metadata to define
the type of project
being uploaded.

5 Choose a metadata set for the asset from the Metadata Set pop-up menu, and add
metadata to one or more fields, defining this as a bundle asset.

6 If necessary, choose a new destination device from the Destination pop-up menu.

This specifies the device on which the file will be stored. If you have questions about
which device to choose, contact your Final Cut Server administrator.

Note: Media and Library are the primary Final Cut Server devices. Talk with your
Final Cut Server administrator about which other configured devices are appropriate
for media file storage.

7 Click the Upload button to create the asset.

The file is uploaded and the bundle asset is created.
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8 After the bundle asset is created, select the Productions pane, click the production you
created, and click the Search button to view the new asset in Final Cut Server.

The bundle asset has a
generic document icon.

Blur_maotion

If you need to identify the bundle asset later, you can open the asset’s info window and
view the metadata you added at upload.

Use the metadata you
added at upload to
identify the bundle asset.

Uploading a Final Cut Studio Project and Its Media Files

as Individual Assets

Choosing to upload a Motion, Soundtrack Pro, or DVD Studio Pro project and its media
files as individual assets creates an asset for each of the files in the folder. The project
file uploads in a manner similar to the Final Cut Pro project file; the big difference is
that unlike a Final Cut Pro project asset, the project’s media files are not referenced to
the project file.

To keep the project and its media together, you can add unique metadata to the assets,
perhaps adding the project name or other useful labels. To conveniently store your project
and media assets together, you can upload the files to a new or existing production.
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The illustration below shows a Final Cut Studio project and its media being uploaded
as individual assets within a Final Cut Server production.

Upload Final Cut Studio project to Final Cut Server

Project Final Cut Server production

gﬁ» i i .mov

BikeBlur.motn Music_3225.aif Motorbikes.aif

¢ W B

Road_3232mov  Rider_322jpg  Quill_5344,pg

Jpeg

&

.aif

Clip Proxy

Note: Each item in the production
is an individual asset.

Important: It is recommended that you upload a Final Cut Studio project file and its
media files into a common production. It is also recommended that you add unique
metadata to the project asset and each of its media assets. This metadata should be
used only on the project asset, media assets, and the production. Adding unique
metadata and creating a production gives you two ways to connect the project asset
and its media assets.

To upload a Final Cut Studio or other project file and its media files
as individual assets:

1 In the Final Cut Studio application, save the project and choose to collect the media. In
Motion and Soundtrack Pro, you can do this by choosing File > Save As and choosing
to collect the media in the Save As window. In DVD Studio Pro, you need to manually
place the project and media files in a folder.

Note: For specific information on using these applications, see the application’s
User Manual.

Important: When uploading a DVD Studio Pro project file and its linked media files,
there is no need to upload .par files. When you check out and open the project in
DVD Studio Pro, the .par files will be automatically recreated.

The project file and its media are saved in a folder at the location you specified.
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2 In Final Cut Server, create a new production for the project and its assets by following
these steps:

a Open the Productions pane by clicking Productions in the column at the left of the
main Final Cut Server window.

b Click the New Production button in the Toolbar.

¢ Choose a metadata set for the new production from the Metadata Set pop-up menu.

d Depending on the production type you chose, a number of production metadata
fields appear. Enter a title and other unique metadata for the project in these fields.
Fields marked with an asterisk (*) must be filled in.

e Click Save Changes to save the new production.

3 Drag the folder that contains the project file and its linked media from the Finder to
the new production in the Final Cut Server Productions pane.

4 A dialog appears, asking you if you want to upload the folder as a bundle asset or as
individual assets. Click Create Individual Assets.

5 A dialog appears, advising you that Final Cut Server is unable to manage references
that may exist in the project file you are uploading. Click Continue.

The Multiple Link Upload window appears. Note that the Associate with Production
field shows the production that you dragged the folder to.

AT Muliiple Link Upload

The name of the
production that you
dragged the folder to
appears here.

v Advaneed Optinns

Add metadata to
differentiate the files
being uploaded.

6 Choose a metadata set for the assets from the Metadata Set pop-up menu.

Add unique metadata to the files being uploaded. Adding project-related metadata will
help you keep track of the assets that are linked to the project asset.
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7 If necessary, choose a new destination device from the Destination pop-up menu.

This specifies the device on which the file will be stored. If you have questions about
which device to choose, contact your Final Cut Server administrator.

Note: Media and Library are the primary Final Cut Server devices. Talk with your
Final Cut Server administrator about which other configured devices are appropriate
for media file storage.

Click the Begin Upload button to create assets for the project file and its linked media files.

The files are uploaded. The upload progress is displayed above the Information pane in
the bottom-left corner of the Final Cut Server main window. If you want to monitor the
progress of the file upload, click the Downloads and Uploads button to display the
Downloads & Uploads window.

After the files are uploaded, select the Productions pane, click the Search button, and
double-click the production to view the new assets.

Each of the individual
assets appears in the
production.

The Final Cut Studio project file and each of its media files have been uploaded as
assets. The assets also appear in the Assets pane of the Final Cut Server main window.
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Organizing and Searching
the Final Cut Server Catalog

This chapter covers:

« An Overview of the Final Cut Server Asset Catalog (p. 49)

« Organizing Assets with Productions (p. 54)

« Using Metadata to Organize and Search Assets (p. 58)

e Searching in Final Cut Server (p. 60)

* Displaying Search Results (p. 68)

» Tracking the Status of an Asset or Production with Metadata (p. 69)
« Adding and Changing Asset Metadata (p. 71)

 Searching Devices and Jobs (p. 72)

When you upload assets, they are added to your Final Cut Server catalog, which is a
collection of assets that are uploaded by you and other Final Cut Server users. As the
number of assets in your catalog increases, creating and managing searches becomes
more important. This chapter covers ways you can use Final Cut Server to organize and
search for your assets.

An Overview of the Final Cut Server Asset Catalog
Before you can organize or search for assets in the Final Cut Server catalog, you must
understand how to view the Assets and Productions panes.

The Assets pane displays all of the assets uploaded to Final Cut Server. You can view all
the assets in your Final Cut Server system by clicking Search in the Final Cut Server
main window.
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Click Assets or
Productions to choose the
type of items to display.

Clicking a Smart Search
also chooses the type of
items to display.

Similarly, the Productions pane displays all of the productions that have been created
in your Final Cut Server system. Productions are used to organize assets; for example, if
you upload a Soundtrack Pro project file and all the audio files used in that project, you
can create a production to hold that project asset and its media assets. Productions are
also used to group related projects, like all the projects in progress for a particular
client. You can view all of the productions in your Final Cut Server catalog by clicking
Productions in the column on the left of the Final Cut Server main window.

You can narrow the number of assets or productions that appear by searching. The
simplest search you can perform is to enter a search term in the search field and click
the Search button. You can also perform an advanced search, which allows you to
search for a term in a particular metadata field. For more information on searching, see
“Searching in Final Cut Server”on page 60.

If you want to keep a search, you can save it. Saved searches are called Smart Searches.
Smart Searches are stored in the column at the left of the main Final Cut Server
window. For more information on Smart Searches, see “Creating a Smart Search”on
page 66.

Your Final Cut Server administrator can customize the advanced search metadata
fields in your Final Cut Server system. For more information, contact your
Final Cut Server administrator.
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An image asset

Asset Icons

Assets can be marked with identifying icons. The icons you'll see on assets include
icons that show that an asset is checked out, locked, and archived, as well as icons that
identify the asset’s type (audio file and video file are two examples) and if a project
asset’s media is unlinked. These icons are useful for getting information about the asset
without having to open the asset’s info window. For a complete list of icons that can
mark an asset, see the table of asset icons in “Views for Assets and Productions Panes”
on page 17.

Types of Assets
Assets can be divided into three general categories: media assets, Final Cut Pro project
assets, and Final Cut Studio or other project assets.

Media assets are created when audio, video, graphic, or other media files are uploaded
to Final Cut Server. Final Cut Pro project assets are created when Final Cut Pro projects
are uploaded to Final Cut Server. The Final Cut Pro project asset info window contains
an Elements pane that lists the media assets that are used by the Final Cut Pro project
file. Final Cut Studio project assets are created when Motion, Soundtrack Pro, and

DVD Studio Pro project files are uploaded to Final Cut Server. Unlike Final Cut Pro
project assets, these project files require you to manually organize the project’s linked
media assets. (Note that a Final Cut Studio project and its media can be uploaded as
either a bundle asset or as individual assets.) For more information about the assets
you can upload to Final Cut Server, see Chapter 2,”Uploading Files to Final Cut Server,”
on page 29.

Many assets display an icon (video, audio, and graphic icons, for example) or an
application symbol on their thumbnails (Final Cut Studio project files, for example).

A video asset ‘ A Final Cut Pro asset

AN Motorbikes 3

A Motion
project asset

An audio asset
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You can also get information about an asset by looking at its mime type. The mime
type describes either the type of information contained in the primary representation
file or the application in which the primary representation file was created.

lalals) O2044001

The mime type for —
this image asset
is shown here.

nnn 3133 Motorbiken

The mime type for this —
Final Cut Pro project
asset is shown here.

You can search for a specific mime type; if you use that search often, you can save it as
a Smart Search. For more information, see “Searching in Final Cut Server”on page 60.
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About the Asset Info Window
Every asset in the Final Cut Server catalog has an expanded window view that provides
detailed information about the asset.

The information shown in an asset info window is determined by the asset’s type. Every
asset info window contains panes of information for the asset.

You can also perform many commands from the asset info window’s Action pop-up menu.

To open an asset’s info window, do one of the following:
= Double-click the asset in the Asset pane or in a production.

= Control-click the asset, then choose Get Info from the shortcut menu.

Click these buttons to
view more information
about the asset.

A video asset
info window

The Action pop-up menu —

In addition to the information displayed in other asset info windows, a Final Cut Pro
project asset info window displays all the elements used in the Final Cut Pro project.

The Elements pane
shows all the project’s
linked media.

A Final Cut Pro project
asset info window
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Organizing Assets with Productions

Productions are used to group related Final Cut Pro projects and assets. You can
create productions to hold any combination of assets and projects that makes sense
in your workflow.

Note: An asset can be associated with one or more productions.

Click a button to display
more information about
the production.

I~ Each of these assets is
contained in the
production.

To create a production:
1 Do one of the following:

« In the Productions pane, click the New Production button in the Toolbar.

Click the New Production
button to create a new
. production.

A new, empty production is created.

* In the Assets pane, select one or more assets and click the New Production from
Selection button in the Toolbar.

The New Production from
Selection button is
available once you select
one or more assets.

A new production is created that contains the assets you selected.
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The Production window appears.

2 Choose a metadata set for the production from the Metadata Set pop-up menu.

Choose a metadata set.

laTate) Production

3 Depending on the metadata set you chose, a number of metadata fields appear. Enter
information for the production, including a title and priority status, in these fields.

Note: Fields marked with an asterisk (¥) must be filled in.

nAN Preduction

A metadata set ~|: s
can contain several

metadata groups.

4 C(lick Save Changes.

The Production window closes.

After you create a production, it appears in the Productions pane.
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To view the production you just created:

1 Click the “Productions created by me” Smart Search to reveal the production you
just created.

The new production

Finad Cut Saever pashibrmdin _azple cam

Click the “Productions —
created by me”
Smart Search to view
the new production.

2 Double-click the production to see its details.

Click Metadata to view
the production’s
metadata.

You can drag assets here
to add them to the new
production.

You can add an asset to the production, either from within Final Cut Server or when
uploading new files to Final Cut Server.
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To add an asset to an existing production window:
Drag the asset from the Assets pane into the open production window.

To add a media or project asset to an existing production at upload,
do one of the following:
Drag the media or project asset from the Finder directly to a production.

Choose Upload File from the Server pop-up menu (the pop-up menu in the
Final Cut Server main window that appears when you click the Server button) and specify
a production to associate the assets with in the Upload or Multiple Upload window.

When the upload is complete, the assets appear in the production that you specified.

Make sure you click the Search button after adding the asset to the production to
refresh the Productions pane.

After you add an asset to a production, Final Cut Server tracks the asset as a linked
asset. You can find out what productions an asset is linked to by opening the asset’s
info window and clicking Resources. A list of productions that the asset is linked to is
displayed in the bottom right of the asset info window.

Click Resources in the
asset info window.

nrn (2044501

This asset is linked to two
productions.
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To remove an asset from a production:
Open the production’s info window.

Select the asset that you want to remove from the production.

Control-click the asset, then choose Remove from Production from the shortcut menu.

Choose Remove from
Production from the
shortcut menu.

The asset is removed from the production.

To delete a production:
In the Productions pane, Control-click the production that you want to delete, then
choose Delete from the shortcut menu.

The production is deleted.

Note: Only the production is deleted. If the production contained assets, none of the
assets are deleted from the Assets pane.

Make sure you click the Search button after deleting the production to refresh the
Productions pane.

Using Metadata to Organize and Search Assets

You can use any of the file metadata that Final Cut Server recognizes to organize and
search for an asset. You can also add metadata about the asset to the asset’s metadata
set. For example, you can create a keyword and then create a saved search in

Final Cut Server for all assets that contain that keyword.
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A combination of file
and asset metadata
is shown here.

About File and Asset Metadata

When you import an asset, it comes in with a variety of metadata. The specific metadata

that a file brings with it into Final Cut Server varies depending on the type of file that the
asset is and the application or applications with which the asset was created and edited.
Some asset types include standard metadata, such as XMP or EXIF metadata.

After upload, metadata can be added to an existing asset. For example, keywords can
be added to identify the project or production that an asset is part of.

All of an asset’s metadata for the file and the asset is shown in an asset’s info window.
This includes the metadata that was imported with the file at upload and the metadata
added in Final Cut Server.

To view the metadata for an asset:
Do one of the following:

* Double-click the asset.
» Control-click an asset, then choose Get Info from the shortcut menu.

Click the Metadata button.

This asset has three In the asset info window,
metadata groups. click Metadata.

— Asset metadata

— File metadata (use the
scroll bar to see more)
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About Metadata Sets

Final Cut Server comes with several metadata sets. Metadata sets sort the many
metadata fields an asset can contain, including asset project and status metadata. You
can use the various metadata within a metadata set to search, sort, and identify assets
in Final Cut Server.

Each of the metadata sets in Final Cut Server contains specific metadata fields. At
upload, file metadata that is readable by Final Cut Server is copied and entered in any
matching metadata fields in the metadata set that you chose for the asset.

It's important to understand that metadata sets do not include all of the metadata that
a media file might include. The metadata set picked for the asset at upload and the
method by which the metadata was added to the file are two factors that influence
what metadata is shown in the asset. Thus, an asset can contain metadata that is not
shown in the metadata set, or not shown in Final Cut Server.

If you need to add metadata to Final Cut Server that is not currently being imported
with a file at upload, contact your Final Cut Server administrator.

Note: If you've added metadata to a QuickTime file using the default QuickTime
annotation fields, that metadata appears in the QuickTime metadata group of the
Media metadata set. You must assign the asset’s metadata set to Media to view the
QuickTime annotation information; if you apply any other metadata set, the QuickTime
metadata is not visible in the Final Cut Server asset.

Searching in Final Cut Server
You can search the Assets and Productions panes in Final Cut Server. You can also
search available devices and search for jobs performed by Final Cut Server.

After configuring a search, you can save the search, making it available to you with one
click of your mouse.

Note: After entering a search term, the search field remembers the term you last
entered. This makes it simple for you to repeat the search you entered previously.
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Doing a Simple Search

To perform a simple search of the Assets or Productions pane in Final Cut Server, you
choose a search type and enter a term. Final Cut Server searches for that term in every
metadata field on every asset or production. Searching is not case sensitive.

In the Simple Search field, you can choose between two simple search types:

» Choosing Contains finds the term you enter within a single metadata field. If, for
example, you enter the term se, Final Cut Server searches for all terms that include se,
including serenade, sunset, and dense, in a single metadata field.

» Choosing Matches Word searches for a particular word or words in every available
metadata field. Matches Word searches are based on stemming, a process that
identifies the root of the word, which gets modified by the grammatical
requirements of the English language. For example, the stem of work, works, worked,
and working is work. Therefore, if you enter the search term working, Final Cut Server
stems the term to work and then returns all assets with a stemmed term of work in
any of the asset’s metadata fields.

Note: In stemming a phrase, common words such as the, a, and, and but are ignored.
You can make simple searches more specific by using a search delimiter.

Search Limiter Example Returns

Multiple search terms hurricane wind water Assets with the terms hurricane,
wind, and water

Search terms in quotation marks “Hurricane Alma” Assets with the entire search
phrase Hurricane Alma

Negative (-) search term “Hurricane -Alma” Assets with the term Hurricane,
(and without the term Alma)
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To perform a simple search:
1 In the Assets or Productions pane, choose a search type (Contains or Matches Word)
from the Search pop-up menu.

2 Enter one or more terms in the search field.

For example, if you want to search for a specific mime type, enter the complete mime
type in the search field.

3 Click the Search button.

Choose a search type
from the pop-up menu. Enter a search term. Then click Search.

Ann [Cuz Sarver. apple com

Every asset that contains the term you entered in its metadata is returned.

Use the View buttons,
Sort pop-up menus,
and page navigation
buttons to further sort
the search results.

FEfmmEnm

The search results are
displayed here.

62 Chapter 3 Organizing and Searching the Final Cut Server Catalog



Doing an Advanced Search
When you click to open the search disclosure triangle, you'll see the advanced search
fields. These fields let you search specific metadata fields for the term or terms you enter.

The Assets and Productions panes have different advanced search fields.

IThe Assets pane’s
advanced search fields

|The Productions pane’s
advanced search fields

The pop-up menu next to each metadata field provides an appropriate search filter. A
search filter sorts the search returns by the filter criteria.
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To perform an advanced search:
1 In the Assets or Productions pane, click the search disclosure triangle to reveal the
advanced search terms.

Open the disclosure
triangle to show the
advanced search settings.

alela Fimad Cut Servrr. m

2 Enter one or more search values or terms in the metadata field or fields that you want
to search.

3 Click the Search button.

The results of your search are displayed in the main part of the window.
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Text Filtering Criteria
Text filtering criteria are used to search Title, Filename, Location, Stored On, and other
metadata fields. You can use the following filters to search these metadata fields:

Filter Definition

All Returns all terms.

Equals Returns only the text entered.

Not Equals Returns assets that do not contain the text entered.
Contains Returns all assets that include the text entered.
Begins with Returns assets that begin with the text entered.

Ends with Returns assets that end with the text entered.
Matches Word Returns the entire word.

Any Of Returns at least one of the words entered in the field.

Date Filtering Criteria

Date filtering criteria is used to search Creation Date, File Creation Date, Deadline, and
other date-related metadata fields. Note that date filtering is relative to the time you
used it; if you create a Smart Search using a date filter, it retains the date on which you
created the Smart Search.

You can use the following filters to search these metadata fields:

Filter Definition

All Returns all numbers.

Last 2 hours Returns all assets that were uploaded or modified within the last
two hours of the last search.

Last 24 hours Returns all assets that were uploaded or modified within the last
24 hours of the last search.

Last 7 days Returns all assets that were uploaded or modified within the last
seven days of the last search.

Last 31 days Returns all assets that were uploaded or modified within the last
31 days of the last search.

Before Returns all assets that were modified before the date you enter.

After Returns all assets that were modified after the date you enter.
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After clicking Save as
Smart Search, a new
Smart Search appears.

The new Smart Search is
added to the Smart
Searches list in
alphabetical order.

Creating a Smart Search
If you want to save a simple or advanced search that you have configured, you can create
a Smart Search. Smart Searches are useful because you can use them again and again.

Note: A Smart Search is only saved for the user who created it. The Smart Search is not
saved to other users’ or the administrator’s Final Cut Server clients.

To create a Smart Search:
After configuring a search, click the Save as Smart Search button in the bottom-right
corner of the Final Cut Server main window.

The Smart Search appears in the Smart Searches list in the column on the left of the
window. It is titled “Untitled” and is selected.

=1 Productions

The search name is saved in Final Cut Server.
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Assets Smart Searches

Productions Smart
Searches

To search the Assets or Productions pane using a Smart Search:
= Click a Smart Search in the list in the column on the left of the main
Final Cut Server window.

The search results appear in the main part of the window.

Once you have created a Smart Search, you cannot modify it. You can, however, delete
a Smart Search at any time.

To delete a Smart Search:

= Control-click the Smart Search, then choose Delete from the shortcut menu.

The Smart Search is deleted.
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Displaying Search Results
In the Assets and Productions pane, you can view your search results in Thumbnail or
List view and change the display order of items using the Toolbar buttons and controls.

Choose a sorting option Choose a specific page
from this pop-up menu. |of search results.

|Choose Thumbnail or Choose the order | Move through the pages
List view. to sort by (ascending of search results.
or descending).

To change the view of your Assets or Productions pane (filtered or otherwise):
Click the Thumbnail View or List View button.

To change the order in which the items are displayed in the Assets
or Productions pane:
Choose a sorting option from the Sort By pop-up menu.

To move between pages of search results:
Use the page navigation buttons to move to the previous or next page or to choose a
different page to display.

Note: The number of items shown per page is set to 25 by default. You can change the
number of items shown per page in the Preferences window.
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Tracking the Status of an Asset or Production with Metadata
Final Cut Server comes with several default Smart Searches and metadata sets that you
can use to determine the status of an asset. The Status metadata set, for example, was
designed to help you track the status of assets and productions in Final Cut Server.
Assets and productions have a slightly different set of Status metadata fields.

For more information about tracking the status of assets and productions, see “Using
Status Metadata to Track Assets and Productions” on page 141.

Important: Your Final Cut Server administrator may have modified the Status or other
metadata available for assets or productions to meet the needs of your organization’s
workflow. If you have questions about the metadata available on an asset, contact your
Final Cut Server administrator.

As your work progresses, you can search for assets that are in a particular phase of your
workflow by searching for their status or other metadata. Final Cut Server comes with
several pre-configured Smart Searches that make it easy for you to find recently-modified
assets or assets marked with the Status metadata field set to Ready for Review.

Click this Smart Search to
see all assets with Status
set to Ready for Review.
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You can configure your own search using the advanced search options. For example,
you can search for all assets that have a Status metadata field set to In Progress. After
setting up a search, you can save it as a Smart Search.

Set the Status field to In
Progress to search
for those assets.

The assets area
highlights to indicate
that the search
configuration does
not match

a Smart Search.

Click this button
to save the current
search setting as

a Smart Search.

Chapter 3 Organizing and Searching the Final Cut Server Catalog



Adding and Changing Asset Metadata

As an asset moves through your organization’s workflow, you may want to add or
change the metadata associated with the asset. For example, when an asset has been
edited and is ready to be reviewed by a client, you can set the asset’s Status metadata
field to Ready for Review.

To add or change the metadata associated with an asset:
Double-click the asset in the Assets pane or in a production.
In the asset info window, click Metadata.
Choose a metadata group to view.

Click Metadata to view

Click a metadata group the asset’s or
to view. production’s metadata.

nNAN

13136 00 -Camera D-Colar

When you've made the
necessary changes, click
Save Changes.

Enter new details in any of the metadata fields or make choices from the pop-up menus.

When you've finished modifying the metadata, click Save Changes.
The changes you made are saved.

Make sure you click the Search button after updating asset metadata to refresh the
Assets pane.
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Click the Server button.

Searching Devices and Jobs

Two advanced user searches, Search Devices and Search All Jobs, are available in the
Final Cut Server client. Depending on your permissions, these searches may or may not
be available for your use. If you have questions about when it is appropriate for you to
use these searches, contact your Final Cut Server administrator.

Searching Devices

If your Final Cut Server administrator has given you permission, you can search for a file
on any device connected to Final Cut Server. This allows you to examine the contents
of a device, including items that have not been added to the Final Cut Server catalog.

The devices that you, as a client user, have access to are determined by your
Final Cut Server administrator. Consider speaking to your Final Cut Server administrator
before searching for or working with a file on a device.

Warning: Use the Search Devices window with caution. When you search a device,
you are searching for files, not Final Cut Server assets. Devices can contain files that
both have and have not been added to the Final Cut Server catalog. From the Search
Devices window, you can add a media file to your Final Cut Server catalog, and copy,
delete, and download the file to your local system; taking some of these actions could
result in making duplicate copies of an asset in your Final Cut Server server system or
deleting all copies of a file from a device.

To search a device:

1 Choose Search Devices from the Server pop-up menu.

— Choose Search Devices
from the pop-up menu.

Log Out

==

Chapter 3 Organizing and Searching the Final Cut Server Catalog




2 In the Search Devices window that appears, choose the device to search from the
Device pop-up menu.

3 Click the Search button to search from the device’s root level. You can also click the
Choose button to open a dialog that allows you to specify a folder to search.

4 If you want to limit the search, enter a term in the search field or click the search
disclosure triangle to reveal advanced searching options.

Important: Be sure to enter entire words in the search field. Unlike the search field in
the Final Cut Server main window, the Search Devices search field does not return full
words if you search for a partial word. For example, if you want to find all assets that
contain the word frame, you must search for the entire word. Searching for fra only
finds assets with the characters fra and the word frame is not found.

5 Click the Search button.

Once you select one or more items, you can choose to do the following actions by
Control-clicking the filename in the list of search results and choosing one of these
options from the shortcut menu:

« Catalog asset: Adds the file to the Final Cut Server catalog.

 Get Info: Displays an info window that summarizes information and metadata for
the file.

« View: Displays the file in the appropriate application (often the location in which the
file was created).

* Export: Exports the file.
» Duplicate: Duplicates the file.
 Delete: Deletes the file from the device.
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Click the Server button.

Searching for a Job

Final Cut Server uses jobs to perform actions like uploading, downloading, and
transcoding files. You can search for a specific job that is running or has been run on
Final Cut Server using the Search All Jobs window.

About Jobs
Final Cut Server performs tasks using jobs. The number of jobs that run depends on the
type of action being performed. Some examples of jobs include:

» Copying a file from one location to another runs one job.
» Creating a new asset runs jobs to perform the initial copy and then creates the asset.
* Analyzing an asset uses multiple jobs to create the asset’s proxy files.

Each job creates multiple log entries for each step of the operation.

If you want to monitor the Final Cut Server jobs that are being performed, you can open
the Jobs window. In it, you can search for specific jobs and then see the job's details.

To search for a specific job or jobs:
Choose Search All Jobs from the Server pop-up menu (the pop-up menu in the
Final Cut Server main window that appears when you click the Server button).

000

— Choose Search All Jobs
from the pop-up menu.
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2 Enter your search criteria by doing one of the following:

 Enter a word or value in the search field.
* Click the search disclosure triangle to reveal the advanced search options. Choose a
limiter from the pop-up menu and enter a value in one or more search fields.
3 When you've entered the criteria by which you would like to search the jobs, click the
Search button.

The jobs that match your search criteria appear in the main part of the window.
Remember that your search results may span several pages; you can navigate through
the search results using the page controls at the right of the window.
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Working in Final Cut Server

This chapter covers the following:

« Final Cut Server Client Actions (p. 78)

» About the Asset Info Window (p. 79)

» Viewing an Asset (p. 83)

+ Adding Versions for a Media or Project Asset (p. 85)
 Locking and Unlocking an Asset (p. 87)

e Writing Annotations on a Video Asset (p. 92)

» Duplicating an Asset (p. 96)

« Using the Edit-in-Place Feature (p. 97)

* Monitoring Jobs (p. 97)

 Setting Final Cut Server Client Preferences (p. 100)

This chapter explains how to work with all types of assets in the Final Cut Server client.
It explains how to interpret the information that is contained in a project or media
asset info window. It also includes descriptions of all the actions available in

Final Cut Server.
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Final Cut Server Client Actions
This section gives an overview of the actions you can perform from the Toolbar,
shortcut menus, and other locations in the Final Cut Server client.

This table describes the various actions you can perform in Final Cut Server:

Action Description

Get Info Provides information and metadata for the selected asset.
For more information, see “About the Asset Info Window" on
page 79.

View Provides a view of the asset in an appropriate media viewer; the

viewing application could be QuickTime Player, Preview, or another
media application.

For more information on viewing an asset, see “Viewing an Asset”
on page 83.

Add to Cache Adds a copy of the asset to the local computer’s cache. This is the
first step in performing many operations in Final Cut Server.

For more information, see “About Caching” on page 103.

Check In/Check Out/Cancel Checking out the asset allows you to edit the primary
Check Out representation being tracked by the asset and prevents the asset
from being modified by all other users.

For more information about checking out a media asset, see
“Checking Out, Editing, and Checking In a Media Asset”on

page 105.

For more information about checking out a Final Cut Pro project,
see “Checking Out a Final Cut Pro Project” on page 118.

For more information about checking out a Final Cut Studio project
asset or checking out a bundle asset, see Chapter 7,“Working with
Final Cut Studio Projects,”on page 129.

Prepare for Disconnected Use Creates alias copies of media assets. You can use this action to
create copies of video assets, and then use those assets to create a
new Final Cut Pro project while you are disconnected from the
Final Cut Server network.

For information on working with an existing Final Cut Pro project
when not connected to the Final Cut Server network, see “Working
on Final Cut Pro Projects While Away from the Final Cut Server
Network”on page 124.
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Action Description

Lock/Unlock Prevents other users from editing the file contained in the asset.

For more information on locking, see “Locking and Unlocking an
Asset” on page 87.

Archive To/Restore Archiving an asset creates a restorable copy of an asset.

For more information on archiving, see “Archiving and Restoring
Media Assets” on page 156.

New Production from Selection  Creates a new production for the selected asset or assets.

For more information, see “Organizing Assets with Productions” on
page 54.

Duplicate Creates a copy of an asset.
For more information, see “Duplicating an Asset” on page 96.

Export Creates a copy of the asset to the local file system or a
external volume.

For more information, see “Outputting a Final Project” on page 153.

Delete Deletes the asset, its primary representation file, and all of its proxy
files from the Final Cut Server catalog.
For more information, see “Deleting Assets from Final Cut Server”
on page 158.

The icons displayed in —

the Assets pane also
appear in the individual
asset info window.

About the Asset Info Window

When you double-click an asset in the Assets pane or from inside a production, the
asset’s info window appears. Final Cut Server uses the information in the info window
to track and manage the asset.

Clicking any of these
buttons displays specific
information about the
asset.
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About Media Asset Info Windows

Media asset info windows contain panes for information about metadata, resources,

versions, locks, and the Review and Approve feature.

* Metadata pane: This pane shows the metadata for both the asset and its primary
representation file. You can update any field in this pane by typing text or a value
and then clicking the Save Changes button.

1136_09-Camera D-Calor

* Resources pane: This pane shows information about the primary representation and
proxy files created for the asset. It also shows other places the asset is used and other
assets that this asset is linked to.

1136_09-Camera D-Calor

Representation

Instances of this asset are used by

This asset is linked to
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« Versions pane: This pane shows different versions that have been created for the
asset. For more information about creating versions, see “Adding Versions for a Media
or Project Asset” on page 85.

3136_09-Camera D-Calor

« Locks pane: This pane shows information about any locks on the asset. For more
information about locks, see “Locking and Unlocking an Asset” on page 87.

3136_09-Camera D-Calor

Chapter 4 Working in Final Cut Server

81



82

* Review and Approve pane: If your Final Cut Server administrator has set up the
Review and Approve feature, the Review & Approve pane is used for sending out
review notification emails. Your Final Cut Server administrator must set up this
feature for it to work properly. For more information about the Review and Approve
feature, see “About the Review and Approve Feature” on page 146.

3136_0%-Camera D-Calor

The info window for a media asset also contains a Refresh button that you can use to
update the asset info window, and an Action pop-up menu that contains commonly
used actions. The info window for a video asset also contains an Annotations button
that opens the Annotations window.

The Actions
pop-up menu

Video assets have an
Annotations button.

The Refresh button
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About Final Cut Pro Project Info Windows

An info window for Final Cut Pro projects is slightly different than the windows for other
types of assets. Its Action pop-up menu does not have all of the items in the Action
pop-up menu for other types of assets because certain actions cannot be performed on
a Final Cut Pro asset. It also contains an additional pane, the Elements pane.

The Elements pane
shows the items
that are part of the
Final Cut Pro project.

A Final Cut Pro project
asset info window

Final Cut Pro project elements are representations of the clips that are used in the
Final Cut Pro project. Final Cut Server creates the elements from the media assets that
are created when the Final Cut Pro project is uploaded to Final Cut Server. For more
information about elements, see “Uploading Final Cut Pro Projects” on page 37.

Viewing an Asset

You can view many video, audio, and image assets. For video and image assets, you can
choose to view the file’s original media, or one of several proxy files. After you choose a
type of file to view, it opens in QuickTime Player or in another appropriate application
(this could be the application in which the file was created).

Note: Keep in mind that Final Cut Server cannot preview any bundle assets or
Final Cut Pro or other project files.
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To view an asset, do one of the following:
= Click the media icon in the asset thumbnail.

Click an asset’s icon to — =]
view the asset.

The asset you selected appears in an appropriate viewing application. The video clip
shown in this example appears in QuickTime Player.

Ta el 4_3136_09-Camera D Ll

When you view an image, the full-sized image appears.

All of the information and metadata for a media file and its asset are displayed in the
asset info window.
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The version checkbox is —
selected, indicating that
version control is turned

on for this asset.

1
2
3

Select the versions
checkbox to be able to
create versions for

this asset. —

Adding Versions for a Media or Project Asset

Final Cut Server can track an asset as you edit it, providing a version for each change
made to the primary representation of each file. If your Final Cut Server administrator
turned on asset version control during the installation process, your system may
already be making versions for assets as you check them out and then back in.

You can see if version control is turned on for an asset by viewing the Versions pane in
the asset’s info window. When the version control feature is turned on, you can view an
asset’s versions in an asset’s info window.

Three versions exist for
this asset.

When you check in an updated version of the asset, the previous version appears in the
version list. Final Cut Server numbers the versions in the order they are created;
therefore, the version with the highest number is the most recent version of the asset.

Note: The current version of the asset does not appear in the list. Only the previous
versions appear.

Important: When the version control feature is turned on for an asset, Final Cut Server
creates a copy of every version that is checked in. Before enabling Final Cut Server to
track versions of an asset, check that you have sufficient disk capacity. If you have
questions about whether you should turn on the version control feature for a particular
asset, contact your Final Cut Server administrator.

To verify that version control is turned on for an asset:
Double-click the asset.
Click the Versions button.

If the “Store and track versions of this asset” checkbox is not selected, select it.

Click Versions to enable
versions for this asset.
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Control-click a version to
open a shortcut menu.

To check out and edit the asset:
Select the asset, then do one of the following:

» Click the Check Out button in the Toolbar.
» Control-click the asset, then choose Check Out from the shortcut menu.

In the Check Out window that appears, enter a check out location and click Check Out.
Edit the asset.

When you're finished editing, save the asset.

To check in the edited asset as a new version:

Select the asset, then do one of the following:

* Click the Check In button in the Toolbar.
» Control-click the asset, then choose Check In from the shortcut menu.

If you want, you can add a comment in the Version Comment field in the Check In
window that appears.

arare Check In 02142913

Click the Check In button.

When you check in an updated version of the asset, the previous version appears in the
version list.

Important: You will not see the comment you just added to the version you checked in
since it is the current version and the Versions pane only shows older versions.

When you Control-click a version in the Versions pane, the shortcut menu that
appears includes:

« Get Info: Select this option to view information about the version.
« View: Select this option to view the version in an appropriate viewer.
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Select an asset, then click
the Lock button to lock
or unlock an asset.

» New Asset from Version: Click this option to create a new asset from the version or to
copy the selected version of an asset to another device.

* Revert to this Version: Click this option to delete the assets that were created after the
selected version. When you revert to a previous version, the current version is
replaced with the selected version.

Your Final Cut Server administrator has configured the version control feature to meet
your organization’s needs. To get more information on other ways to configure version
control, contact your Final Cut Server administrator.

Locking and Unlocking an Asset
In Final Cut Server, locks function to protect the primary representation file, proxy files,
and metadata in the asset.

There are several types of locks. The User lock is the most obvious lock because it is the
only lock that you apply manually. The User lock is applied to an asset from the Toolbar
or from the asset’s shortcut menu. You can tell an asset is locked when you see the
“locked by me” or “locked by other”icon on an asset’s thumbnail.

The yellow lock icon A white lock icon
indicates that you have indicates that someone
locked the asset. else has locked an asset.

nan Final Cut Secvrr. tamitmadisierves apple cam

Checkout and Reference locks are not applied manually. They are applied when you
check out a Final Cut Pro project asset.

The following sections describe the types of locks you will find in Final Cut Server.
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User Lock

You or another user can put a User lock on an asset by clicking the Lock button in the
Toolbar or by choosing Lock from the asset’s shortcut menu. After a User lock has been
applied to an asset, a lock icon (either “locked by me” or “locked by other”) appears on
the asset’s thumbnail. Also, the lock that was applied is noted as a User lock in the
Locks pane of the asset info window.

The Locks pane shows
the lock details.

lalala) (3044001

When you lock the asset, the primary representation of the file cannot be edited,
checked out, deleted, or archived by another user.

Important: A User lock does not prevent the asset’s metadata and proxy files from
being edited by you or another user.

Note: When you lock an asset, only you can successfully check it out. If an asset is both
locked manually and checked out, the asset is locked with both a Checkout and User
lock. If someone other than the person who locked the asset attempts to check out the
asset, the checkout will fail.

Checkout Lock

A Checkout lock is applied when an asset is checked out by you or another user.

lalaltel (02044001

The Lock Type
shows that this
is a Checkout lock.

When an asset is checked out, no part of the asset, including the primary
representation of the file, proxy files, or metadata, can be edited, and the asset cannot
be edited, checked out, deleted, or archived.
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For more information about checking out a media asset, see “Checking Out, Editing,
and Checking In a Media Asset” on page 105. For more information about checking out
a Final Cut Pro project, see “Checking Out a Final Cut Pro Project” on page 118. Also see
“Reference Lock,” next. For more information about checking out a Final Cut Studio
project asset, see Chapter 7,“Working with Final Cut Studio Projects,” on page 129.

Reference Lock

When a Final Cut Pro project asset is checked out, the project asset is locked with a
Checkout lock. In addition to the Checkout lock, each of the media assets linked to the
project are locked with a Reference lock. Reference locks are not indicated on the
media asset’s thumbnail; you can only find evidence of a Reference lock in the Locks
pane in the asset’s info window.

Note that there is no
indication that this asset
is locked.

The Lock Type shows that
this is a Reference lock.

Important: A Reference lock does not prevent the Final Cut Pro project or a media
asset’s metadata from being edited by you or another user, or prevent a media asset
from being used in another Final Cut Pro project.

Locking and Unlocking Assets with a User Lock
This section explains how to lock and unlock an asset using the User lock.

Only the person who locked the asset and your Final Cut Server administrator can
unlock a locked asset. If you need access to a locked asset, talk to the person who
locked it or your Final Cut Server administrator.
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To apply a User lock to an asset, do one of the following:
= Select the asset in the Assets pane, then click the Lock button in the Toolbar.

= Control-click the asset, then choose Lock from the shortcut menu.

Select the asset and click
the Lock button.

Alternatively, you can
Control-click the asset,
then choose Lock from
the shortcut menu.

After locking an asset, a lock icon appears on the asset, indicating that the asset is
locked. In other Final Cut Server clients, the lock icon looks different, indicating that
another user has locked the asset.

The yellow lock indicates The white lock indicates
that you have locked the that another user has
asset. locked the asset.

To unlock an asset that you locked, do one of the following:
= Select the asset in the Assets pane, then click the Unlock button in the Toolbar.
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= Control-click the asset, then choose Unlock from the shortcut menu.

Select the asset and click
the Unlock button.

Alternatively, you can
Control-click the asset,
then choose Unlock from
the shortcut menu.

The icon disappears, and the asset is unlocked.

If an asset is locked by another user, you can open that asset’s info window and view
the Locks pane to find out which user has locked the asset.

This icon indicates this
asset is locked by
someone else.

Talala: 02044301

The Locked By field
shows who locked
the asset.
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Writing Annotations on a Video Asset

You can add annotations to a video asset. In the Annotations window, you can view a
video clip and then add text at different points in the video clip. Because the annotations
stay with the clip asset in Final Cut Server, annotations are useful for making notes for
yourself or others in your workgroup. You can easily view these annotations in

Final Cut Server.They stay with the asset until you manually clear the annotation.

Annotations that have

been entered
The Viewer window

Add annotations here.

To annotate a video asset:

1 Locate the video asset you want to annotate in the Assets pane, in a production, or in a
Final Cut Pro project asset’s Elements pane.

2 Double-click the clip asset to display the asset’s info window.

3 Click the Annotate button in the asset info window.

Click the Annotate
button in a video asset’s
— asset info window.
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The Annotations window appears.

You must mark an In point or an Out point for each annotation.

4 Position the playhead at the In point, either by dragging the playhead or using the
navigation controls. Then click the Mark In button or press | on your keyboard.

You can set an Out point using the same process.

Click the Mark In

and Mark Out buttons
(or press your keyboard's
| or O key) to mark In

W —— and Out points.

Drag this slider to locate
frames of video.

Click this button to open —
the asset’s info window.

Use these controls to
play and navigate
through the video.

Important: The keyboard commands are not available when the Annotation field is
active. This allows you to type annotations in the field.
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5 Type a comment in the Annotation field below the viewer window.

The annotation

The In and Out points
associated with the
annotation

Click the Add Annotation
button to save the
annotation.

6 To add the annotation to the Annotation list at the right, click the Add Annotation button.

The annotation is added to the list.

The annotation you
added appears in this list.

To replace the text of an existing annotation:
1 Click the In or Out Point button in the Annotation list.

an Feb 15, 2008 9:06:25 AM

The In Point button | |The Out Point button

2 In the Annotation text field, enter new text for the annotation.
Click Add Annotation.

4 A dialog appears, asking if you want to replace the annotation. Click Yes.

The annotation is replaced.
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To delete one or more selected annotations from the Annotation list:
Select one or more annotations you wish to delete.

Control-click the annotation and choose Delete Selected from the shortcut menu.

You can also click the
delete button to delete
a single annotation.

Control-click an
annotation to open this
shortcut menu.

The selected annotation or annotations are deleted.

To delete all the annotations on an asset:
Select any annotation you wish to delete.

2 Control-click the annotation, then choose Delete All from the shortcut menu.

3 Adialog appears, asking you to confirm that you want to delete the annotations. Click Yes.

All of the annotations are deleted.
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Duplicating an Asset

Choosing to duplicate an asset creates a copy of the asset in Final Cut Server. If you
want to create two distinct iterations of a media or project asset, you can easily do so
by duplicating the asset.

To duplicate an asset:
Control-click the asset, then choose Duplicate from the shortcut menu.

The Duplicate window appears.
Select a destination device from the Destination pop-up menu.

If you want to place the duplicate file within the file structure of the device, click the
Choose button and navigate to the appropriate location in the file browser.

The destination file path appears in the Destination field.

If you want to associate the new asset with a production, click the Choose button to
the right of Production, select a production, and click Open.

The production you selected appears in the Associate with Production field.

If you want to transcode the asset, change the metadata set, or add metadata to the
asset, click the Advanced Options disclosure triangle and make the necessary changes.

Click the Duplicate button to duplicate the file and create a new asset.
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Using the Edit-in-Place Feature

Your Final Cut Server administrator can configure the edit-in-place feature and create
copies of assets for editing directly on an Xsan server or other shared storage locations.
When the edit-in-place feature is set up, you no longer need to download, cache, or
check out the asset; instead, you can drag your asset directly from the asset catalog to
an application for editing.

Important: Edit-in-place must be set up by your Final Cut Server administrator.
Contact your administrator to find out if edit-in-place is configured before you try to
use the feature.

Monitoring Jobs

Files are constantly being uploaded and downloaded by Final Cut Server. The job
progress indicator, Downloads & Uploads window, and Search All Jobs window all
display information about the progress of files being uploaded to and downloaded
from Final Cut Server.

The Jobs in Progress Indicator

The Jobs in Progress indicator appears in the bottom-left corner of the Final Cut Server
main window when files are being uploaded or downloaded. It looks like a spinning
gear and indicates that a certain number of jobs are being performed.

Jobs in Progress ¥ — The Jobs in Progress

3 % indicator
|

Click this button to
display the Downloads
& Uploads window.
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Open the disclosure —
triangle to view the files
that are part of a job.

The Downloads & Uploads Window

For more information about files being uploaded or downloaded, you can open the
Downloads & Uploads window, which shows the specific files being downloaded and
information about the status of each.

Note: The Downloads & Uploads window does not show details about files being
transcoded to create proxy files. You can see the details about the transcoding of these
files in the Search All Jobs window.

To open the Downloads & Uploads window:
Click the Downloads and Uploads button in the bottom-left corner of the
Final Cut Server main window.

Note: If an upload or download fails, an error icon appears in the Downloads & Uploads
window. You must clear the jobs listed in the Downloads & Uploads window to make this
icon disappear.

MO Dowriboads & Uploads

To clear the jobs listed in the Downloads & Uploads window:
Click Clear in the bottom-left corner of the Downloads & Uploads window.

The Search All Jobs Window

You can get detailed information about each of the files being uploaded or
downloaded in the Search All Jobs window. Unlike the Downloads & Uploads window,
the Search All Jobs window contains a detailed history of the jobs Final Cut Server has
performed. Jobs are shown for copying a file from one location to another, uploading
files, creating the new asset’s proxy files, and more. Each job also creates multiple log
entries for each step of the operation.

To narrow the jobs shown in the Jobs window, you can search the Jobs window.
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To search for a specific job or jobs:
1 Choose Search All Jobs from the Server pop-up menu.

Click the Server button.

— Choose Search All Jobs
from the pop-up menu.

The Search All Jobs window appears.

Enter a search term.

Click this button to see
advanced search options.

2 Enter your search criteria by doing one of the following:
 Enter a word or value in the search field and limit the search to find files that contain
the search term as part of the title using the “Contains (more results)” option or that
match the search term exactly using the “Matches Word (faster)” option.
* Click the search disclosure triangle to reveal the advanced search options. Choose a
limiter from the pop-up menu and enter a value in one or more search fields.
3 When you've entered the criteria by which you would like to search the jobs, click the
Search button.

The jobs that match your search criteria are listed in the Search All Jobs window.
Remember that your search results may span several pages; you can navigate through
the search results using the page controls at the far right.
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Setting Final Cut Server Client Preferences

Your Final Cut Server administrator is responsible for configuring most of the
preferences that affect you while working with your Final Cut Server client. However,
there are a few settings that you can change in your client copy only.

A Preferences for mediasenverapple.com

You can change how
the search results in your
I— client are displayed.

— You can define the
location and size of
your cache memory.

To configure user preferences settings, do one of the following:
= Choose Final Cut Server > Preferences.

= Choose Preferences from the Server pop-up menu (the pop-up menu in the
Final Cut Server main window that appears when you click the Server button).

To make changes in the Preferences window:
= Enter a number or enter a file path (by clicking the Choose button and then specifying
a file path) in the field you want to change, then click the Apply Changes button.

About Search Preferences
The search preferences control the number of results Final Cut Server finds and how
many items are displayed per page. This can be useful if you have a large or small display.

Searching preferences include:

* Maximum # of Search Results: Enter a value that is the maximum number of items
that appear after a search.

« [tems Per Page: Search results are divided into pages to make viewing more efficient.
You can enter a value that defines how many items appear on each page.

* Remember the last search: Select this checkbox to have Final Cut Server remember
and run the last search that you performed the next time you log in.

100 Chapter 4 Working in Final Cut Server



About Cache Preferences

The cache is where your local copies of media files are downloaded. It is not suggested
that users view or move files that are in the cache. Instead, export copies of files that
you want to use to your desktop or another convenient location.

However, you can decide where you want your cache to be located. In the Preferences
window, you can change the location and size of the cache. You can also quickly clear
the cache in the Preferences window.

Cache preferences include:

* Cache location: Click the Choose button to choose a location to use for storing your
caches. The default locations are /username/Library/Caches/ when running the client on
a Macintosh computer and the /username/AppData/ directory on a Windows computer.

Important: Changing the cache location results in all current caches becoming
unavailable. If you change the cache’s location, you will need to manually add assets
that you need to the new cache location.

* Maximum Cache Size: Enter a value to define a maximum cache size.
» Clear Cache: Click the Clear Cache button to delete the files in the cache location.

« Saved aliases for prepared media files: Click the Choose button to choose a location to
use for storing aliases to cache files. This location is used when you choose the
Prepare for Disconnected Use option for assets.

Note: If your local cache exceeds the limit defined in the Preferences window, an error
message appears, advising you to clear the cache, cancel the action, or continue the
action. It is recommended that you choose to clear your cache.

About the Saved Aliases for Prepared Media Files Field

Preparing media assets for disconnected use allows you to create alias copies of a media
file that is stored in your Final Cut Server cache on a portable computer. You can use the
alias files to create a new Final Cut Pro project while you are disconnected from the

Final Cut Server network. You can set the location where Final Cut Server saves alias copies
of the prepared media files in the Preferences window. For more information about
preparing media assets for disconnected use, see “Preparing Media Assets To Be Used on
a Computer That Is Not Connected to the Final Cut Server Network” on page 107.
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Working with Media Assets

This chapter covers the following:
» About Caching (p. 103)
e Checking Out, Editing, and Checking In a Media Asset (p. 105)

 Preparing Media Assets To Be Used on a Computer That Is Not Connected to the
Final Cut Server Network (p. 107)

» Exporting Media Assets (p. 111)

This chapter explains how to edit media assets, including video clips and graphics, in
applications other than Final Cut Server. You can edit a managed copy of a media asset
by checking out the asset, editing the checked out file, and then checking the edited
file back in. A separate workflow is provided for preparing media files to be used in a
new Final Cut Pro project that you create while disconnected from the Final Cut Server
network. You can also copy or export an unmanaged copy of a media asset from

Final Cut Server.

About Caching

Caching an asset downloads the asset to the Final Cut Server cache on your local
computer. After you've cached a media asset, you can check it out and work with that
managed copy in another application, or you can drag a copy of the media asset from
Final Cut Server or export a copy of the media asset and create an unmanaged copy.

After caching an asset, you can tell the asset is cached because the asset’s thumbnail
changes to a lighter gray color.

Note: If your Final Cut Server system is connected to an Apple Xsan storage area
network (SAN) device and the edit-in-place feature is enabled, your assets are always
cached and ready to use. For more information, contact your Final Cut Server
administrator.

Final Cut Server prompts you when you need to cache an asset, so caching often only
requires you to click the Add to Cache button that appears in the dialog. However, you
can also manually add an asset to your Final Cut Server cache.
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To add an asset to your cache:
= Control-click the asset, then choose Add to Cache from the shortcut menu.

l Getinfo
View

Add to Cache I

8 CheckOut...

Prepare for Disconnected Use

4_2, with the lighter gray —
background, is cached.

In some situations, a file that is stored in your Final Cut Server cache may expire. When
this happens, an icon appears on the asset, indicating that the file that is cached for
that asset is expired.

This icon indicates that
the file that is cached for
this asset is expired.
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To correct an expired cache:
Control-click the asset, then choose Remove from Cache from the shortcut menu.

The icon disappears, indicating that the expired file has been removed from your
Final Cut Server cache.

You can change several settings for your Final Cut Server cache in Final Cut Server
Preferences. For more information, see “About Cache Preferences” on page 101.

Important: Final Cut Server manages the files in your local computer’s cache. In most
situations, you do not need to manually work in your computer’s cache. If you want to
modify your cache, talk with your Final Cut Server administrator.

Checking Out, Editing, and Checking In a Media Asset
A media asset represents a single media file, and as such, is easy to work with. To edit a
media asset, you can check it out, edit it, and then check it back in to Final Cut Server.

A media asset can also be exported, edited, and then uploaded to Final Cut Server as a
new asset; however, when you export a media asset, the asset is no longer managed by
Final Cut Server. If you make changes to the media file and want Final Cut Server to
manage it again, you will need to create a new asset for the file by checking the file
back in to Final Cut Server.

Although a media asset represents a single media file, a media asset is rarely
unattached. Media assets can be referenced as elements of a Final Cut Pro project asset
or referenced in other Final Cut Studio project assets. When you modify an asset, you
could inadvertently be modifying how that asset appears in several different project
assets. It's good practice to always check the Resources pane of a media asset to verify
which projects an asset is linked to.

If you know that the changes you are about to make to an asset apply to every one of
the projects it is connected to, go ahead and edit the asset. If you don't recognize the
linked assets that are shown in the Resources pane, consider exporting the asset and
then uploading it again as a new media asset, and manually replacing the asset in the
necessary projects. Doing this might take a few extra minutes, but it could save you
and your coworkers hours of backtracking later on.

Remember that when a media asset is checked out, the asset cannot be edited,
checked out, deleted, or archived by another user.
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To check out a media asset, edit it, and check the edited media file back in to
Final Cut Server:
1 Locate the media asset that you want to check out.

2 Do one of the following:

« Select the asset, then click the Check Out button in the Toolbar.
» Control-click the media asset, then choose Check Out from the shortcut menu.

Click the Check Out
button.

P = Sort By [None]

3 In the Check Out window that appears, choose a location to save the checked out
media file.

Cancel Check Out

4 (lick the Check Out button.
5 To open the file in its original application, do one of the following:

* Drag the file from Final Cut Server to the application icon in your Dock.
« Drag the file from the checkout location to the original application icon in your Dock.
* Open the file in its original application by choosing File > Open.

6 Edit the file.
7 Save the new file to the checkout location.

Important: Saving to any location other than the original checkout location will
prevent Final Cut Server from managing the file.
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8 In Final Cut Server, check the file back in by doing one of the following:

» Select the checked out asset, then click the Check In button in the Toolbar.
« Control-click the asset, then choose Check In from the shortcut menu.
If version control is not turned on for the asset, the asset is checked in.

9 If version control is turned on for the asset, a Check In window appears. If appropriate,
enter a version comment and click Check In.

TalaTa) Check In 02044801

For more information about version control, see “Adding Versions for a Media or Project
Asset” on page 85.

The updated media asset is checked back in to Final Cut Server, and the checkout icon
disappears from the asset thumbnail.

Preparing Media Assets To Be Used on a Computer
That Is Not Connected to the Final Cut Server Network

Sometimes you may want to make a selection of media assets available to be used
in a new Final Cut Pro project that you create while not connected to the
Final Cut Server network.

Preparing media assets for disconnected use allows you to create alias copies of a media
file that is stored in your Final Cut Server cache on your local computer. Later, when you
are away from the Final Cut Server network, you can add those media files to a new
Final Cut Pro project. When you return to work and connect to the Final Cut Server
network, you can upload the new Final Cut Pro project to Final Cut Server.When you do
this, a new asset is created for the Final Cut Pro project, but because the media assets
already exist in Final Cut Server the media is not uploaded.

Important: You can only prepare files for disconnected use on a portable computer
that contains a Final Cut Server local cache. You cannot prepare files for disconnected
use and put the files on an external drive.
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To prepare media assets for disconnected use:

1 Choose Preferences from the Server pop-up menu (the pop-up menu in the

Final Cut Server main window that appears when you click the Server button).

2 In the Final Cut Server Preferences window, verify the location at which the alias files

will be placed. If you want to change the location, click Choose and enter a new
location on your local computer, then click Apply Changes to save the new location.

501 Preferences for mediasenverapple.com

Click the Choose button.

Alias copies of the media files
are placed in the location
specified in this field.

3 In the Assets pane, select the media assets that you want to prepare for

disconnected use.

« To select a series of items, click an item, hold down the Shift key, and click the last
item in the series.

* To select individual items, hold down the Command key, and click discontinuous items.
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4 Control-click one of the selected assets, then choose Prepare for Disconnected Use
from the shortcut menu.

—— Choose Prepare for
Disconnected Use.

The files are copied to the Final Cut Server cache, and alias copies of the files are put in
the location you specified in the “Saved aliases for prepared media files”field in the
Preferences window.

To create a Final Cut Pro project using the files that have been prepared
for disconnected use:
1 Create a new project in Final Cut Pro.

2 Drag the alias files into the new project.

Important: Be sure to maintain the path of the media files in the Prepared for
Disconnected Use location. Do not move the aliases or change the filenames.

You can also add media files that are not being managed by Final Cut Server to the
new Final Cut Pro project. When you upload the new Final Cut Pro project to
Final Cut Server, these new files are uploaded as new media assets.

Edit the project.
4 When you have finished working on the project, save it.
The last piece of this process is to upload the new Final Cut Pro project to
Final Cut Server. When you upload the project, the media assets that you prepared for
disconnected use are updated, if necessary, in Final Cut Server, the new Final Cut Pro

project is uploaded as a new asset, and any new media files are uploaded to
Final Cut Server as new media assets.
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To upload the new Final Cut Pro project to Final Cut Server:
Do one of the following:

« Drag the Final Cut Pro project file from the Finder to the column on the left of the
Final Cut Server main window, the Assets pane, or a production.

» Choose Upload File from the Server pop-up menu (the pop-up menu in the
Final Cut Server main window that appears when you click the Server button), select
the Final Cut Pro project file in the file browser that appears, then click Upload.

The Upload Final Cut Pro Upload window appears.

AL Upload Final Cut Pro Praject

Inlnad

Some of the information in the Upload Final Cut Pro window is automatically entered. If
necessary, you can change the metadata set or add any metadata for the new

Final Cut Pro project and the linked media. Click to move through the metadata
categories on the left to view all the available metadata fields.

If you want to put the Final Cut Pro project asset in a production, click Choose at the
right of the Associate with Production field and specify a production.

For more information about productions, see “Organizing Assets with Productions”on
page 54.

Click Upload.

The file is uploaded and a new asset is created. The upload progress is displayed above
the Information pane in the bottom-left corner of the Final Cut Server main window.

If you want to monitor the progress of the file upload, click the Downloads and
Uploads button to display the Downloads & Uploads window.

After the file is uploaded, select the Assets pane and click the Search button to view the
new asset or assets created from the Final Cut Pro project file and any new media files.
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Exporting Media Assets

Exporting is useful for creating copies of media files for editing or for making a backup
copy. You can export copies of media assets even if the asset is locked or checked out
by another user.

Important: Once you export a media asset, the exported file is no longer managed by
Final Cut Server. If you want to create a managed copy of an asset that can be checked
in and tracked by Final Cut Server, check out the asset.

To export one or more media assets:
1 Select one or more assets, Control-click an asset, then choose Export from the
shortcut menu.

Get Info

i Add to Cache
& Remove from Cache

¥ prepare for Disconnected Use

Lock
Unlock

Archive to
@ Restore

New Production from Selection..

The Export or Multiple Export window appears.

2 In the window, choose a destination to save the media files to by clicking the Choose
button and identifying a location in the file browser.

3 If desired, choose a transcode setting.
4 If you are exporting a single file, you can also optionally change the filename.

5 Click the Start button.

The media file is exported to the location you specified in the Export window.
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Working with Final Cut Pro
Projects

This chapter covers the following:

« About Final Cut Pro Projects (p. 114)

 Using Final Cut Pro and Final Cut Server Together (p. 115)

» Moving Final Cut Pro Projects Between Final Cut Server and Final Cut Pro (p. 117)
¢ Checking Out a Final Cut Pro Project (p. 118)

« Editing a Checked Out Project in Final Cut Pro (p. 120)

e Checking In a Final Cut Pro Project (p. 121)

« Making Versions of Final Cut Pro Project Assets (p. 123)

» Working on Final Cut Pro Projects While Away from the Final Cut Server
Network (p. 124)

 Exporting a Final Cut Pro Project (p. 127)

This chapter explains how to work with Final Cut Pro projects. You can edit

Final Cut Pro projects by checking out the project asset, editing the checked out file in
Final Cut Pro, and then checking the edited file back in to Final Cut Server. A separate
workflow is provided for editing a Final Cut Server-managed copy of a Final Cut Pro
project while you are not connected to the Final Cut Server network. You can also
export a copy of a Final Cut Pro project from Final Cut Server.
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About Final Cut Pro Projects

When you upload a Final Cut Pro project to Final Cut Server, the Final Cut Pro project is
uploaded as an asset, and each media file that is linked to that Final Cut Pro project
asset is also uploaded as an independent media asset, called an element of that project.
Final Cut Server uses elements to track the linked media assets. Elements are listed in
the project asset’s Elements pane.

A Final Cut Pro project asset is always linked to one or more Final Cut Pro sequences, as
well as to the media that is used in the project. The element relationship allows
multiple Final Cut Pro project assets to reference the same media assets.

Click Elements in a
Final Cut Pro project
asset info window.

nnn 3133 Motorbiken.

Each element references
an independent asset.
Control-click an element
to open the media asset’s
info window.

To view an element’s asset:
Control-click the element, then choose Show Master Asset from the shortcut menu.

This opens the asset referenced by the element. Viewing an element’s asset can be
useful for tracking an element’s source asset.
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Using Final Cut Pro and Final Cut Server Together

There are several ways you can work with a Final Cut Pro project:

* You can check out the Final Cut Pro project. Checking out a Final Cut Pro project is the
best way to work with it, because the checked out project and media assets are
managed by Final Cut Server. After you've modified the project, you can check it back
in, updating the project in Final Cut Server with any changes. Optionally, you can turn
on version control and automatically save checked in versions of the project.

* You can export the Final Cut Pro project. This is a good choice if you need to use or
share an unmanaged copy of a Final Cut Pro project. However, it's important to
remember that exported Final Cut Pro projects are not managed by Final Cut Server.
If you decide you want to update a Final Cut Pro project that you previously exported
from Final Cut Server, you will have to upload the updated copy as a new
Final Cut Server asset.

Whether you are uploading a new Final Cut Pro project into Final Cut Server or
checking back in an existing Final Cut Pro project asset to Final Cut Server, it's
important to understand the following:

« Final Cut Server does not support folder hierarchies in the Final Cut Pro bin. Iltems you've
organized in the Final Cut Pro bin come into Final Cut Server in a flat structure.

« Final Cut Server does not recognize markers set in Final Cut Pro. Markers and marker
comments created in Final Cut Pro cannot be viewed in Final Cut Server. However,
when you check out or export a Final Cut Pro project from Final Cut Server, the
markers and their text appear again in Final Cut Pro.

» Remember to save checked out project files. Save checked out project files often, and
only save them to the Final Cut Server checkout location. Do not move checked out
files from their checkout location.

* Remember that projects that are exported from Final Cut Server are no longer managed
by Final Cut Server. You cannot update an existing Final Cut Pro Project asset in
Final Cut Server unless you have checked out the asset, edited it, and then checked it
back in. If you edited a Final Cut Pro that was exported or duplicated, it is no longer
managed by Final Cut Server.
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Resolving Offline Media Issues

After uploading or checking in a Final Cut Pro project, you may find that one or more of
the project’s media files have gone offline. You'll know that the media is offline because
an offline icon appears on the asset.

This icon shows that one
or more of the project’s
media files are offline.

Final Cut Server cannot modify a Final Cut Pro project’s media links. While Final Cut Server
is managing a Final Cut Pro project, media can go offline because the project asset was
uploaded incorrectly, or because the media files went offline while the project was being
edited in Final Cut Pro and was then uploaded with offline media.

If the project’s media was not linked correctly at upload or checkin and went offline
when it was uploaded to Final Cut Server, you should check out the project, relink the
media, and then check it back in to Final Cut Server.

If the project’s media is unlinked in Final Cut Pro, you should attempt to relink the
media in Final Cut Pro.
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Moving Final Cut Pro Projects Between Final Cut Server
and Final Cut Pro

After uploading a Final Cut Pro project, it's easy to revise and update the original
project. Simply check out the project, modify it in Final Cut Pro, save it, and then check
the project back in. At checkin, the Final Cut Server project asset is updated in

Final Cut Server.

Important: Your Final Cut Server administrator can create a copy of the asset for
editing directly on an Xsan server, thus eliminating the need to download, cache, or
check out the asset; instead, you can drag your asset directly from the Assets pane to
an application for editing. To do this, edit-in-place must be set up by your

Final Cut Server administrator. Ask your Final Cut Server administrator if edit-in-place is
configured on your Final Cut Server system.

You can save versions of previous project assets by turning on version control. After
turning on version control, you can save a copy every time a new version of an asset is
checked in. For more information about version control, see “Adding Versions for a
Media or Project Asset”on page 85.

Remember that checking out the Final Cut Pro project is the only way to maintain the
project asset. If you export a copy of the Final Cut Pro asset, or if you simply drag the
asset out onto your desktop, you are creating an unmanaged copy of the Final Cut Pro
project that is not tracked by Final Cut Server. If you make changes to an unmanaged
Final Cut Pro project, you will have to upload it to Final Cut Server as a new asset.

Chapter 6 Working with Final Cut Pro Projects

117



118

Checking Out a Final Cut Pro Project

Checking out a Final Cut Pro project creates a managed copy of the project at the
location you specify. When you check out a Final Cut Pro project, the project asset’s
primary representation is locked and cannot be modified by other users. Additionally,
every media asset that is used in the project is locked with a Reference lock and cannot
be modified by other users.

If the Edit Proxy feature has been turned on by your Final Cut Server administrator, you
will have the option to check out the original media or the Edit Proxy that was created.
Using Original Media provides the video asset’s primary representation; using Edit
Proxy provides the video asset’s Edit Proxy file.

Important: The Edit Proxy feature must be turned on by your Final Cut Server
administrator. If this feature has not been turned on, you will only be able to check out
the original media.

You also have the option to create copies of the project’s linked media at checkout.
Because all linked media is copied to your computer’s Final Cut Server cache at
checkout, the only time you need to include linked media is when you are checking a
project out to an external drive. For more information, see “Working on Final Cut Pro
Projects While Away from the Final Cut Server Network” on page 124.
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To check out a Final Cut Pro project:
1 In the Assets pane or within a production, do one of the following:

« Select the Final Cut Pro project that you want to check out, and then click the Check
Out button in the Toolbar.

» Control-click the Final Cut Pro project that you want to check out, then choose Check
Out from the shortcut menu.

Alternately, you can

Select the Final Cut Pro select the asset and
asset and click the Check choose Check Out from
Out button. the shortcut menu.

The Check Out Final Cut Pro window appears.

[T5 ats! Check Qut Final Cut Pro Pro

— Click Choose to define
a checkout location.

Click Check Out.

2 In the Check Out Final Cut Pro Project window, choose a location to save the checked
out Final Cut Pro project to by clicking the Choose button and identifying a location in
the file browser.

Note: To avoid losing track of checked out projects, you can create a “Checked
out Final Cut Server Projects” or similar folder on the desktop or in another
convenient location.
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3 If the Edit Proxy feature has not been enabled, original media will be used by default. If

the Edit Proxy feature has been enabled, choose Original Media or Edit Proxy from the
Use pop-up menu.

This defines the media type that will be used while you're editing the project.

Note: Select the Keep Media with Project checkbox only if you are planning to edit the
project when your computer is not connected to the Final Cut Server network. For
more information, see “Working on Final Cut Pro Projects While Away

from the Final Cut Server Network” on page 124.

Click the Check Out button.

The Final Cut Pro project asset is marked with the checkout icon in Final Cut Server. A
copy of the project is downloaded to the checkout location you specified. All media
linked to the checked out project is added to the Final Cut Server cache. When the
project is opened in Final Cut Pro, this locally cached media is used to automatically
reconnect to the checked out project.

You can track the checkout progress by watching the Jobs in Progress indicator or, for
more information, you can open the Downloads & Uploads window.

Editing a Checked Out Project in Final Cut Pro

When you have checked out a Final Cut Pro project, you can edit the project in
Final Cut Pro.

When you open a project file that you just checked out in Final Cut Pro, the project file
should open with all of its media links intact.

To open a checked out project in Final Cut Pro:
Drag the project from its Checkout location to the Final Cut Pro icon in your Dock.
The project opens in Final Cut Pro. Now you can edit the project as you want.

Note: You should not have to manually relink the project’s media files. If you do have to
relink the media files, the project was probably uploaded to Final Cut Server with
unlinked media.
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To save a checked out Final Cut Pro project:
Save the project in the location you specified at checkout.

Important: You must save the project in exactly the same location from which you
checked it out. Not saving your Final Cut Pro project before checking it back in will not
maintain the edits you performed.

About Using Media Manager with a Checked Out Project

Using the Final Cut Pro Media Manager to organize a project that is managed by
Final Cut Server can cause various media management problems. You can use the
Media Manager to organize a project’s media before you upload the project to

Final Cut Server, but using the Media Manager while Final Cut Server is managing the
project is not recommended.

Checking In a Final Cut Pro Project

When you check a Final Cut Pro project back in to Final Cut Server, the new project
replaces the project that you checked out. Any linked media (including unused media
that is in a bin or folder) is updated, and any new media that was added is uploaded to
Final Cut Server.

If you are using version control with the Final Cut Pro project, the older checked out
project is saved as a version of the project asset. If you are not using version control,
the old project asset is overwritten.

Checking in a project removes both the Checkout lock that was applied to the
Final Cut Pro project asset and the Reference locks that were applied to the media assets.

Chapter 6 Working with Final Cut Pro Projects
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To check a project back in to Final Cut Server:
In the Assets pane or in a production, do one of the following:

» Select the asset, then click the Check In button in the Toolbar.
« Control-click the project, then choose Check In from the shortcut menu.

Alternately, you can

Select the Final Cut Pro select the asset and
asset and click the Check choose Check In from
In button. the shortcut menu.

When you check in the project, a Check In window appears.

£ Check In Final Cut Pro Project.

If version control is
turned on, the Version
Comments field appears.

Enter any appropriate
metadata.

Click Check In.

2 If version control is turned on, you can type comments in the Version Comments field.

3 If you have added new media files to the Final Cut Pro project, you can choose a

metadata set for the new media asset and add metadata to any of the available fields.

4 When you're ready to check in the project, click the Check In button.
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Final Cut Server uploads the new, edited project as well as any new linked media in the
project. If version control is turned on for the project asset, the old project is saved as a
version; if version control is not turned on, the old project is overwritten.
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Making Versions of Final Cut Pro Project Assets
Final Cut Server can track Final Cut Pro project files as you edit them, providing a
version for each changed version of a project that is checked in to Final Cut Server.

If your Final Cut Server administrator turned on asset version control during the
installation process, your system may already be creating new versions of assets as you
revise them.

Important: When version control is turned on for an asset, Final Cut Server creates a
copy of every version that is checked in. Before enabling Final Cut Server to track
versions of an asset, check that you have sufficient disk capacity. If you have questions
about whether you should turn on the version control feature for a particular asset,
contact your Final Cut Server administrator.

To create a version of a Final Cut Pro project asset:

Verify that the version control feature is turned on for the Final Cut Pro project asset by
doing the following:

a Double-click the project asset to reveal the asset’s info window.

b Click the Versions button.

c If the “Store and track versions of this asset” checkbox is not selected, select it.

02044901

Check out the Final Cut Pro project by doing one of the following:

» Click the Check Out button in the Toolbar.
« Control-click the asset, then choose Check Out from the shortcut menu.

In the Check Out window that appears, enter a checkout location and click Check Out.
Edit the Final Cut Pro project.

When you've finished editing, save the project.

Check in the Final Cut Pro project by doing one of the following:

» Click the Check In button in the Toolbar.
» Control-click the asset, then choose Check Out from the shortcut menu.
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7 Add a comment in the window that appears.

ANA Check In Final Cut Pra Praject.

Type comments about
this version here.

8 C(lick the Check In button.

When you check in an updated version of the asset, the previous version appears in the
Versions pane of the asset’s info window.

Working on Final Cut Pro Projects While Away

from the Final Cut Server Network
You can easily work on checked out projects while your computer is not connected to
the Final Cut Server network.

When you check out a project, you get to choose the location to check the project out
to. You also get to choose whether or not to include copies of the linked media assets
at the checkout location.

Select this checkbox to

include copies of the

linked media files at the
checkout location. —

How you use these options depends on the device you are checking the project out to.
You can either check out a project on a system that has been connected to
Final Cut Server, like a laptop computer, or to an external drive.
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If you are checking out the project to a computer that is connected to the

Final Cut Server network (for example, a portable computer that you carry between
your work and your home), you do not need to include the linked media in your
checkout. This is because the media files are stored in the computer’s Final Cut Server
cache. The checked out Final Cut Pro project will reference the media files that are
stored on your local computer, the same computer that you have carried home to edit
with. After checking out the project, you can carry your computer home and edit the
checked out project while you are not connected to the Final Cut Server network.
When you go back to work the next day, you can log in to Final Cut Server and check in
the edited project.

If you are checking the project out to an external drive, you must include the linked
media in your checkout. You do this by selecting the Keep Media with Project checkbox
in the Check Out window. Because the Final Cut Server cache is stored on your local
computer, a project that is checked out to an external drive will not have access to the
media files that are used in the Final Cut Pro project. Including the media in your
checkout location provides those files.

To check out a Final Cut Pro project to a portable computer for editing while not
connected to the Final Cut Server network:
Log in to Final Cut Server using the computer on which you want to check out the project.

In Final Cut Server, locate the Final Cut Pro project asset that you want to check out.
Do one of the following:

« Select the Final Cut Pro project, then click the Check Out button in the Toolbar.

« Control-click the Final Cut Pro project, then choose Check Out from the shortcut menu.

In the Check Out Final Cut Pro window, choose a location to save the checked out
Final Cut Pro project to by clicking the Choose button and identifying a location in the
file browser.

Note: To avoid losing track of checked out projects, you can create a “Checked
out Final Cut Server projects” or similar folder on the desktop or in another
convenient location.

Click the Check Out button.

The Final Cut Pro project asset is marked with the checkout icon in Final Cut Server. The
project and its linked media files are downloaded to your Final Cut Server cache
location, and an alias to the cached copy of the Final Cut Pro project is created in the
location you specified in the Check Out Final Cut Pro Project window.
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You can track the progress of the checkout by watching the Jobs in Progress indicator.
The spinning gear indicates that Final Cut Server is downloading copies of the files
you checked out, and the number indicates the number of files being downloaded.
For more information, you can open the Downloads & Uploads window, which shows
the specific files being downloaded and information about the status of each
downloaded file.

To check out a Final Cut Pro project to an external drive that will be connected
to a computer that is not connected to the Final Cut Server network:
Locate the Final Cut Pro project that you want to check out.

—_

2 Do one of the following:
« Select the Final Cut Pro project, then click the Check Out button in the Toolbar.
« Control-click the Final Cut Pro project, then choose Check Out from the shortcut menu.

3 In the Check Out Final Cut Pro window, navigate to the external drive you will be using
to transport the Final Cut Pro project by clicking the Choose button and identifying a
location in the file browser.

Note: To avoid losing track of checked out projects, you can create a “Checked out
Final Cut Server Projects” or similar folder.

S

If the Edit Proxy feature has not been enabled, original media will be used by default. If
the Edit Proxy feature has been enabled, choose Original Media or Edit Proxy from the
Use pop-up menu.

This defines the media type that will be used while you're editing the project.
5 Select the Keep Media with Project checkbox.

Important: If you do not select the Keep Media with Project checkbox while checking
out a project to an external drive, the media files will not be available for you to use later.

el Check Out Final Cut Pro Project

Make sure that the Keep
Media with Project
checkbox is selected. —

6 Click Check Out.

The Final Cut Pro project asset is marked with the checkout icon in Final Cut Server.The
project and its media files are checked out to the location on your external drive that
you specified in the Check Out window.
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Exporting a Final Cut Pro Project

You can always export a copy of a Final Cut Pro project for editing, even if a project is
locked or checked out by another user. Exporting without a transcode yields a simple
copy of the project and its media, ready for editing.

Important: Exported project files cannot be checked in or otherwise referenced to the
original Final Cut Pro project asset. If you want to track an exported Final Cut Pro
project in Final Cut Server, you must upload it as a new asset.

To export a copy of a Final Cut Pro project:
Control-click the Final Cut Pro project asset, then choose Export from the shortcut menu.

In the Export Final Cut Pro window, choose a location to save the exported
Final Cut Pro project file and its media to by clicking the Choose button and identifying
a location in the file browser.

Note: To avoid losing track of exported projects, you can create a “Checked
out Final Cut Server Projects” or similar folder on the desktop or in another
convenient location.

If you want local copies of the media used in the project, choose Original Media or Edit
Proxy from the Use pop-up menu.
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4 Select the Keep Media with Project checkbox.

This provides local copies of the media files.

Select the Keep Media
with Project checkbox.

5 Click the Export button.

A copy of the project file and its media files are exported to the location you specified
in the Export Final Cut Pro window.

Important: Remember, you cannot check an exported Final Cut Pro project file back in
to Final Cut Server. If you want to track this exported copy in Final Cut Server, you must
upload the project file as a new asset.
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Working with Final Cut Studio
Projects

This chapter covers the following:

» About Editing Final Cut Studio Project Assets (p. 129)

e Checking Out, Editing, and Checking In Bundle Assets (p. 130)

 Checking Out, Editing, and Checking In Final Cut Studio Projects and Their Media
Files (p. 132)

» Exporting a Project Asset and Its Media (p. 137)

This chapter is similar to Chapter 6,”Working with Final Cut Pro Projects,” in that it
explains how to perform the tasks explained in Chapter 6 for Motion, Soundtrack Pro,
and DVD Studio Pro projects and their linked media files that are being managed by
Final Cut Server. However, working with Final Cut Studio project and media assets
requires different strategies than working with Final Cut Pro project assets. Be sure to
read both chapters so you can familiarize yourself with the different ways of working
with Final Cut Pro and Final Cut Studio project assets and their linked media files.

About Editing Final Cut Studio Project Assets
Final Cut Server can manage Soundtrack Pro, Motion, and DVD Studio Pro project
assets and their linked media files.

Unlike Final Cut Pro project assets, Final Cut Studio project assets do not contain
elements that represent the project’s linked media files. Therefore, the media files that
are referenced by a Final Cut Studio project asset must be explicitly tracked by

Final Cut Server users. Final Cut Server provides two methods for managing

Final Cut Studio projects and their linked media files.
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Navigate to the location
you want to save the
checked out bundle
asset.

1

When you upload a folder containing the project file and media files, Final Cut Server
displays a dialog asking you if you want to upload the folder as a bundle asset or as
individual assets. This chapter explains how to check out and export Final Cut Studio
projects that have been uploaded using either of these options.

How you check out a Final Cut Studio project depends on how you uploaded it. If you
uploaded the project and its linked media files as a bundle asset, you can check out the
bundle asset in the same way that you would check out a media asset. If you uploaded
the project file and its linked media files as individual assets, you need to separately
check out the project asset and each of the media assets.

Checking Out, Editing, and Checking In Bundle Assets

When you check out a bundle asset, the project file and its linked media files are all
contained in the folder that appears at the checkout location. You can check out the
bundle asset to any location and have access to the project and media files whether or
not you are connected to Final Cut Server.

Remember that when you check out an asset, it is locked with a Checkout lock and the
asset’s primary representation cannot be modified; however, the asset’s metadata can
be modified by any user.

To check out a bundle asset, edit it, and check it back in:
Do one of the following:

« Select the Final Cut Studio asset that you want to check out in the Assets pane orin a
production, then click the Check Out button in the Toolbar.

» Control-click the media asset, then choose Check Out from the shortcut menu.

2 In the Check Out window that appears, choose a location to save the checked out

bundle asset by navigating to the desired location.
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Click the Check Out button.

The folder of files that was contained in the bundle asset appears in the location
you specified.

To open the project file in its original application, do one of the following:

« Drag the project file from the checkout location to the original application icon in
your Dock.

» Open the original application, choose File > Open, then navigate to the project file.

Edit the file.

Save the new file to the checkout location.

Important: Saving to any location other than the original location prevents
Final Cut Server from managing the file.

In Final Cut Server, check the folder back in by selecting the checked out bundle asset

in the Assets pane or in a production and do one of the following:

» Select the checked out bundle asset, then click the Check In button.

» Control-click the checked out bundle asset, then choose Check In from the
shortcut menu.

If version control is not turned on for the bundle asset, it is checked in. If version
control is turned on for the bundle asset, a Check In window appears. If appropriate,
enter a version comment and click Check In.

=Talal Check In MatarbikeBlus_mation

For more information about version control, see “Adding Versions for a Media or Project
Asset”on page 85.

The updated folder is checked back in to Final Cut Server.
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Checking Out, Editing, and Checking In Final Cut Studio
Projects and Their Media Files

If you uploaded a project and its linked media files as individual assets, you need to
individually check out the project asset and each of the media assets. If the

Final Cut Studio project asset and its linked media assets were put in a Final Cut Server
production and given unique metadata at upload, finding and downloading the

Final Cut Studio project and its media is easy. You can open the production or search
for the project keyword to find the project and media assets. Then you can check out
the project and each of its media assets.

If the Final Cut Server project upload was not explicitly organized with a production or
keyword, you may need to download the project, open it in its original application, and
then manually search for the media needed for the project. Then you can download
each piece of media and edit the project. When you check the project back in, you can
organize the project in a production and apply a project keyword.

Remember that when you check out any asset, it is locked with a Checkout lock and
the asset’s primary representation cannot be modified; however, the asset’s metadata
can be modified by any user.

Checking Out a Final Cut Studio Project Asset

and Its Linked Media Assets

Before you can successfully open a project, you need to check out or export copies of
the project’s media assets. Checking out an asset is the only way that you can create a
managed copy of the asset that you can check back in to Final Cut Server. Check out
the project asset using the steps below and then check out each of the media assets.
After checking out all of the media files, you can open the project file, reconnect the
media files, and begin editing.
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To check out a Final Cut Studio project asset or media asset:
Do one of the following:

« Select the project asset in the Assets pane or in a production, then click the Check
Out button in the Toolbar.

« Control-click the project asset, then choose Check Out from the shortcut menu.

In the Check Out window, choose a location to save the checked out project to by
navigating to the desired location.

Note: To make it easier to reconnect the project’s media, save the project file and all its
linked media files in the same location. You can create a “Checked out Final Cut Server
projects” or similar folder on the desktop or in another convenient location.

Click the Check Out button.

The project is checked out to the location you specified.

After checking out all of the media assets, you can open the project file, reconnect the
media files, and begin editing.

If you will not be editing the media files, you can export the files. Because you can
export multiple files, this is the faster choice. For instructions on exporting media files,
see “Exporting a Project Asset and Its Media” on page 137.
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Editing a Project File in Its Original Application
After checking out the project asset and checking out or exporting the project’s media
assets, you can open the project file in its original application.

To open a project file in its original application, do one of the following:
= Drag the project from the location to which you checked it out to the appropriate
application icon in your Dock.

= Open the original application, choose File > Open, then navigate to the project file.

Once the project is open in its original application, you can edit it. Be sure to save your
edits often.

You may need to relink your project file to its media files. If you get a media offline or
relink message, you'll know that the project needs to be relinked. For more information
about relinking project files, see the documentation that came with the application.

Reconnecting a Motion Project to Its Media Files

When you first open a project file with media that is unavailable, a dialog appears
listing all the media files that can’t be found. You can display a dialog to navigate
directly to the files without having to search.

To reconnect Motion media files:
1 Inthe dialog listing all of the media files that cannot be found, click Reconnect.

2 In the dialog that appears, navigate to each file’s location, then click Open.

The media is reconnected.

For more information about reconnecting Motion projects, see the documentation that
came with the application.

Reconnecting a Soundtrack Pro Project to Its Media Files

When you open a Soundtrack Pro multitrack project, the application checks to see if

the media files the project uses exist in the same location they were in when the

project was last opened. If the media files are not in the expected location,

Soundtrack Pro displays a Can't Find File dialog with three choices:

* Skip All: Opens the project without reconnecting any missing files.

* Skip File: Opens the project without reconnecting the missing file.

* Locate: Presents a dialog that lets you locate the missing file and reconnect it to
the project.
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To reconnect Soundtrack Pro media files using the Locate option:
In the Can't Find File dialog, click Locate.

The window that appears displays the filename that needs to be reconnected as
the window’s title. In the file browser that appears in the window, navigate to the
file's location.

When you've identified the file location, click Open.
The file is reconnected.
If you choose to open the project in Soundtrack Pro without reconnecting its files, you

can reconnect individual audio files from the Timeline or the Bin tab and reconnect a
video file in the video track in the Timeline.

To reconnect an audio or a video file in Soundtrack Pro:
Control-click the clip in the Timeline or video track, then choose Reconnect [filename]
from the shortcut menu.

In the dialog that appears, locate the file you want to reconnect.
Click Open to reconnect the file.

For more information about reconnecting Soundtrack Pro projects, see the
Soundtrack Pro User Manual.

Reconnecting a DVD Studio Pro Project to Its Media Files

If the project file and all its media files are in the same folder, DVD Studio Pro projects
should not need to be reconnected. However, if you open a project and DVD Studio Pro
cannot locate an asset in its original location, a Missing Files window appears.

To locate a missing asset when opening a DVD Studio Pro project:
Select the asset in the Missing Files window.
Do one of the following:

 Click Locate and use the window that appears to find the asset.

« |f the asset is a QuickTime file and its MPEG-2 or AIFF encoded version is available,
you can click “Replace with encoded file.”

For more information about reconnecting DVD Studio Pro projects, see the
DVD Studio Pro User Manual.
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Checking the Project and Its Linked Media Files Back

In to Final Cut Server

After you've edited the project file, you need to check it and its linked media files back
in to Final Cut Server. Each asset must be checked in separately.

Note: If you added any new assets to a project, you have to upload them separately.
For more information, see “Uploading Final Cut Studio Projects” on page 40.

To check in a project asset:
In the project’s original application, save the project to the checkout location.

In the Final Cut Studio application, save the project and choose to collect the media. In
Motion and Soundtrack Pro, you can do this by choosing File > Save As and choosing
to collect the media in the Save As window. In DVD Studio Pro, you need to manually
place the project and media files in a folder.

Note: For specific information on using these applications, see the documentation that
came with the application.

Important: When uploading a DVD Studio Pro project file and its linked media files,
there is no need to upload .par files. When you check out and open the project in
DVD Studio Pro, the .par files are automatically recreated.

In Final Cut Server, check the project file back in by doing one of the following:

« Select the checked out project asset in the Assets pane or in a production, then click
the Check In button in the Toolbar.

« Control-click the project, then choose Check In from the shortcut menu.

If version control is not turned on for the asset, the asset is checked in. If version
control is turned on for the asset, a Check In window appears. If appropriate, enter a
version comment and click Check In.

For more information about version control, see “Adding Versions for a Media or Project
Asset”on page 85.

The Final Cut Studio project file is checked back in to Final Cut Server.
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To check in a media asset:
In Final Cut Server, check the file back in by doing one of the following:

 Select the checked out media asset in the Assets pane or in a production, then click
the Check In button in the Toolbar.

« Control-click the checked out media asset, then choose Check In from the
shortcut menu.

If version control is not turned on for the asset, the asset is checked in. If version
control is turned on for the asset, a Check In window appears. If appropriate, enter a
version comment and click Check In.

For more information about version control, see “Adding Versions for a Media or Project
Asset”on page 85.

The updated media asset is checked back in to Final Cut Server.

Exporting a Project Asset and Its Media

You can always export a copy of a Final Cut Studio project asset and its media files that
were uploaded as bundle asset, or a project asset and media assets that were uploaded
as individual assets, even if the project or media assets are locked or checked out by
another user. However, it's important to note that exported project and media files
cannot be checked in or otherwise referenced to the original project or media assets.

If you uploaded the original project and its media files as a bundle asset, you can
export the bundle asset in one step. If you uploaded the original project and its media
files as individual assets, you need to export the project asset, then export all of the
media assets. Exporting media assets takes less time than checking out media assets,
because you can export multiple assets from Final Cut Server.
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To export a copy of a bundle asset:
1 Control-click the bundle asset, then choose Export from the shortcut menu.

Add to Cache

Check Out...

Prepare for Disco

The Save window appears.

2 In the Save window, choose a destination to save the exported bundle asset to by
clicking the Choose button and identifying a location in the file browser.

e @%e Save

Saveln: [ Checkouts

3 Do not choose a transcode setting for the bundled asset.

4 Click the Export button.

A copy of the folder that is contained in the bundle asset is exported to the location
you specified in the Export window.
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To export a Final Cut Studio project asset and linked media assets that were
uploaded as individual assets:

Select the project asset and media assets. If the project and media assets were created
using the recommended method, the assets should be grouped in a Final Cut Server
production and have metadata that is unique to the project and media assets.

For more information on the recommended method for uploading a Final Cut Studio
project and its media files as individual assets, see “Uploading Final Cut Studio Projects”
on page 40.

Note: Switching to List view in the Productions pane can make it easier to Shift-click a
list of assets.

Control-click one of the selected assets, then choose Export from the shortcut menu.
The Multiple Export window appears.

In the Multiple Export window, choose a destination to save the media assets to by
clicking the Choose button and identifying a location in the file browser.

Note: To avoid losing track of exported projects, you can create a folder for the project
and its media on the desktop or in another convenient location.

Do not choose a transcode setting.

Click the Start button.

Each of the selected assets is exported to the location you specified in the Multiple
Export window.
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Using Status Metadata
in the Final Cut Server Workflow

This chapter covers the following:

« Using Status Metadata to Track Assets and Productions (p. 141)
« About the Review and Approve Feature (p. 146)

 Using the Review and Approve Feature (p. 147)

This chapter explains how to use the Status metadata field to aid in tracking assets
through your Final Cut Server workflow. If your organization diligently updates the
Status metadata field on each of its assets and productions, you can easily search for
every asset and production that is in each stage of the workflow process. This chapter
also discusses using emails to notify others when an asset’s Status metadata field is set
to Ready For Review.

Using Status Metadata to Track Assets and Productions
The Status metadata field is designed to reflect where an asset is in the
Final Cut Server workflow.

This Final Cut Pro
project asset’s status
is set to In Progress.
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As your work progresses, you can perform searches to find assets that are in a
particular phase of the workflow. Final Cut Server comes with several pre-configured
Smart Searches that make it easy for you to find recently modified assets or assets with
their Status metadata field set to Ready for Review.

The Smart Search
changes the Status
setting in the advanced
search.

Click this Smart Search to
see all assets with Status
set to Ready for Review.

The Smart Search
changes the Checked
Out By setting in the
advanced search.

Click this Smart Search to
see all assets you have
checked out.
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You can configure your own search using the advanced search options. For example,
you can search for assets with their Status metadata field set to In Progress.

Set the Status field to In
Progress to search for
those assets.

B
B -
B
T L
L

Click thais button to
save the current search
setting as a Smart Search.

After setting up a search, you can save it as a Smart Search. Saving it allows you to
access the search by simply clicking it in the Smart Searches list.

m@femmEn

Clicking the Save as
Smart Search button
adds a new Smart Search
that you can then name.
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Applying Status Metadata to an Asset or Production
You can apply status and other metadata when you upload the file or after the asset or
production has been created.

Important: When you apply metadata to an asset or production, it is not applied to
other associated assets. For example, if you change the status of a Final Cut Pro project,
the status on each of the linked media assets does not change.

To change an asset or production’s Status metadata:
In the Assets or Productions pane, double-click the asset or production to view its
info window.

Click Metadata to view the Metadata pane.
Click Asset to view the Asset metadata group.
Depending on the metadata set for the asset or production, several groups of

metadata are displayed.

Click Metadata to see the

Click Asset to view the asset’s metadata sets and
Asset metadata group. their fields.
L o i ! 02044501
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4 Choose the appropriate Status setting from the Status pop-up menu.

Choose a status setting
from the Status pop-up
menu.

Click Save Changes.

5 Click the Save Changes button.

The metadata is modified.

Searching for Assets or Productions Using Status Metadata
After defining the status of an asset or production, you can search for status metadata
to find all assets or productions that contain a particular Status metadata setting.

To search for assets or productions by status:
1 In the Assets or Productions pane, click the Search disclosure triangle to reveal the
advanced search options.

Click the disclosure Click the Search button
triangle to show the once you configure the
advanced search settings. search settings.

LN la) Final Cut Secver. amibradisiever apple cam

Choose a Status setting
to search for.

2 Choose a Status metadata setting to search for from the Status pop-up menu.

3 Click the Search button.

The results of the search are displayed in the main part of the window.
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Smart Searches for the

Smart Searches for the
Productions pane

Using Smart Searches to Locate Items Ready for Review
Final Cut Server comes with a Smart Search configured to search for assets and
productions that have their Status metadata field set to Ready for Review.

To search for assets or productions that have the Status metadata field
set to Ready for Review:

= (Click"Assets ready for review” or “Productions ready for review” in the Smart Searches list.

About the Review and Approve Feature

The Review and Approve feature works in conjunction with the Status metadata field.
When an asset is ready for review, you can easily change the asset’s Status metadata
field to Ready for Review, add editorial comments, and send a notification email to
required reviewers from within the Final Cut Server client. Using the information in the
email, the reviewers can find, view, annotate, and approve assets without having to
download large files.

The Status metadata
choices for an asset
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Important: Your Final Cut Server administrator must configure this feature before it
works as described in this section.

Click Review & Approve
to enter comments and
email addresses.

You can set the Status in —
the Metadata or

Review & Approve pane.
Depending on how your

administrator configured
the Review and Approve
feature, you can enter
comments and email
addresses here.

Using the Review and Approve Feature

When your Final Cut Server administrator installed Final Cut Server, he or she set up the
Review and Approve feature to meet your organization’s needs. The options the
administrator could configure included writing the text of the email, making editor’s
comments (which are entered in the Review & Approve pane) and other metadata
appear in the body of the notification email, and more.

The administrator also chooses one of three ways to specify who is defined as a
required reviewer and thus receives Review and Approve emails. Emails can go to an
administrator-defined recipient list, emails can go to the addresses that the user
manually enters in the “Required reviewers” field, or emails can go to both the
administrator-defined recipient list and any addresses manually entered in the
“Required reviewers” field by the user.

Note: These examples show ways for you to manually enter email addresses.
Depending on how your Final Cut Server system has been configured, your
administrator can create a pop-up menu that you can use to assign email addresses.
For more information, contact your Final Cut Server administrator.

Important: It is difficult for a Final Cut Server client user to discern if the Review and
Approve feature has been set up, and if it has been, to discern which of these three
approaches your Final Cut Server system uses. Your Final Cut Server administrator
should be your first point of contact for questions about using the Review and Approve
feature with your Final Cut Server system.
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Sending Review Emails to Administrator-Defined Reviewers

In this configuration, the Final Cut Server administrator manually enters each required
reviewer’s email address during setup. As a result, the Final Cut Server user does not
see the list of required reviewers and cannot manually enter email addresses in the
“Required reviewers” field of the Review & Approve pane.

When the email addresses have been entered manually by the administrator, email
notifications are automatically sent whenever the Status metadata field is set to Ready
for Review (and any time the asset is modified while it is set to Ready for Review).

This configuration is best if you know that the same set of reviewers should receive
Review and Approve email notifications for all assets. Also, this configuration does not
require you to enter required reviewer email addresses; in fact, if you enter email
addresses, they are ignored.

To send Review and Approve email notifications to a set of defined reviewers:
Locate the asset or project that you want to send out for review in the Assets or
Productions pane, then double-click the asset or project to display its info window.

2 In the asset or project info window, click to open the Review & Approve pane.

Click to open the
Review & Approve pane.
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3 If you want to add notes to the email, you can type them in the “Editor’s comments” field.

Type comments in the
“Editor’s comments” field.

When you're ready
to send the email
notification, click
Save Changes.

4 When you are ready to send the email notification to the required reviewers, change
the Status metadata field to Ready for Review.

Note: The Status metadata field is available in both the Metadata and the Review &
Approve panes.

5 Click the Save Changes button at the bottom of the Review & Approve pane.
This change causes the notification email to be sent.
Note: Your Final Cut Server administrator controls who can receive email within

the Final Cut Server system. To add email addresses to Final Cut Server, contact
your administrator.

Entering Reviewer Email Addresses Manually
For this configuration, the Final Cut Server user must manually enter the complete
email address of each required reviewer.

After the email addresses have been entered, saving the changes prompts the Review
& Approve email to be sent. The email is not sent unless the changes are saved.

This configuration lets the user choose who receives the email and how often review
emails are sent. However, this configuration is less automated, requiring more work for
the user.
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To manually define who receives Review and Approve email notifications:
Locate the asset or project that you want to send out for review and double-click the
asset or project to reveal its info window.

In the asset or project info window, click to open the Review & Approve pane.
If you want to add notes to the email, you can type them in the “Editor’s comments” field.

Enter a full email address for each of the required reviewers for this asset in the
“Required reviewers” field.

Enter a full email address
for each required viewer.

When you're ready
to send the email
notification, click
Save Changes.

When you are ready to send the email notifications to the required reviewers, change
the status of the metadata field to Ready for Review.

Note: The Status metadata field is available in both the Metadata and the Review &
Approve panes.

Click the Save Changes button at the bottom right of the Review & Approve pane.

The notification email is sent to each of the addresses you entered in the “Required
reviewers” field.

Using Administrator-Defined Reviewers with Manually Entered
Reviewer Email Addresses

A hybrid approach lets the Final Cut Server administrator enter a static list of required
reviewers while also letting the user manually enter additional email addresses in the
“Required reviewers” field. This approach allows both the administrator and the user to
control who gets notification emails.
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To manually define who receives Review and Approve email notifications:
Locate the asset or project that you want to send out for review and double-click the
asset to reveal its info window.

In the asset or project info window, click to open the Review & Approve pane.
If you want to add notes to the email, type them in the “Editor’s comments” field.

Enter a full email address for each of the required reviewers.

The addresses that you enter are added to the list of reviewers that was set up by your
Final Cut Server administrator.

Enter a full email address
for each of the required
reviewers.

When you're ready
to send the email
notification, click
Save Changes.

Important: Remember, your Final Cut Server administrator also defined a list of
reviewers who will receive every email sent from the Review & Approve pane. Be
careful not to send duplicate emails to reviewers by manually adding their addresses in
the Review & Approve pane.

When you are ready to send the email notifications to the required reviewers, change
the status of the metadata field to Ready for Review.

Note: The Status metadata field is available in both the Metadata and the Review &
Approve panes.

Click the Save Changes button at the bottom right of the Review & Approve pane.

The notification email is sent to each of the addresses you entered in the “Required
reviewers” field and to each of the required reviewers that your Final Cut Server
administrator entered as default required reviewers.
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Exporting, Archiving, and Deleting
Completed Assets and Projects

This chapter covers the following:

» Outputting a Final Project (p. 153)
 Archiving and Restoring Media Assets (p. 156)
« Deleting Assets from Final Cut Server (p. 158)

This chapter covers the final steps of working with an asset: outputting a final copy and
creating backup copies of assets. It also explains how to delete assets and productions
from Final Cut Server.

Outputting a Final Project

You can use the Export command to output media and project assets. You can export
to an external drive or another backup device, or you can export to your local system
and then move the files using the Finder.

If you are exporting a media asset, you can transcode the asset during export. However,
transcoding Final Cut Studio project assets and bundle assets is not recommended.

How you export your final project or media asset depends on the asset type. This
chapter presents steps for exporting a Final Cut Pro project, a Final Cut Studio or other
project asset and its linked media assets, a single media file, and a bundle asset.

Important: After you export an asset from Final Cut Server, the asset is no longer
tracked by Final Cut Server.
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Exporting a Media Asset
Exporting an individual media asset is simple.

To export an individual media asset:
1 Control-click the asset, then choose Export from the shortcut menu.

The Export window appears.

2 In the Export window, choose a destination to save the media asset to by clicking the
Choose button and identifying a location in the file browser.

Click the Choose button to
change the export location.

If desired, choose a
transcode setting.

Click Export.

If desired, choose a transcode setting.

4 Click the Export button.

The media asset is exported to the location you specified in the Export window.

154 Chapter 9 Exporting, Archiving, and Deleting Completed Assets and Projects



Exporting a Final Cut Pro Project and Its Linked Media Assets

You can export a Final Cut Pro project asset and all its linked media assets in one process.

To export a copy of a Final Cut Pro project and its linked media assets:
Control-click the asset, then choose Export from the shortcut menu.

The Export Final Cut Pro window appears.

In the Export Final Cut Pro window, choose a location to save the exported

Final Cut Pro project file and its linked media files to by clicking the Choose button and

identifying a location in the file browser.

If the Edit Proxy feature has not been enabled, original media will be used by default.

If the Edit Proxy feature has been enabled, choose Original Media or Edit Proxy from
the Use pop-up menu. This defines the media type that will be exported.

Select the Keep Media with Project checkbox to include the media files in the export.

Important: If you don't select the Keep Media with Project checkbox, only the
Final Cut Pro project asset is exported.

Click the Export button.
A copy of the project is exported to the location you specified in the Export
Final Cut Pro window.

Note: After export, the project and media files are no longer tracked by
Final Cut Server.

Exporting a Final Cut Studio Bundle Asset

When you uploaded the Final Cut Studio project file and its media files, you chose to
upload either a bundle asset that contained the project file and media files, or to
upload the project file and each of its media files as independent assets. If you
uploaded the project file and its media files as a bundle asset, you can export the
bundle asset in one simple step.

To export a bundle asset:
Control-click the bundle asset, then choose Export from the shortcut menu.
The Export window appears.

In the Export window, choose a destination to save the bundle to by clicking the
Choose button and identifying a location in the file browser.

Click the Export button.

The folder that the bundle asset contains is exported to the location you specified in
the Export window.
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Exporting a Final Cut Studio Project and Individual Media Assets
If you uploaded a Final Cut Studio project asset and media assets as individual assets,
you need to export the project asset, then export all of the media assets.

To export a copy of a Final Cut Studio project asset and its linked media assets:
1 Select the Final Cut Studio project asset and all of the project’s linked media.

Note: Switching to List view in the Productions pane can make it easier to Shift-click a
list of media assets.

2 Control-click one of the selected assets, then choose Export from the shortcut menu.
The Multiple Export window appears.

3 In the Multiple Export window, choose a destination to save the media files to by
clicking the Choose button and identifying a location in the file browser.

Note: To avoid losing track of exported projects, you can create a folder for the project
and its media on the desktop or in another convenient location.

4 Do not choose a transcode setting.

Click the Start button.

Each of the selected media files is exported to the location you specified in the Multiple
Export window.

Archiving and Restoring Media Assets

You can move the primary representation of a media asset to the archive device that
was set up by your Final Cut Server administrator. Because only the primary
representation is moved, the asset stays in the Final Cut Server catalog so you can still
locate the asset and search its metadata. The primary representation file, however, is
safely archived and cannot be downloaded or modified.

If you attempt to archive a media asset that is being used by a project asset, a dialog
will appear, asking you if you want to continue the archive process. If you choose to
continue, the media asset will not be available for the project.

If you have questions about archiving, contact your Final Cut Server administrator.
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To archive an asset:
= Control-click the media asset, then choose “Archive to” and an archive device from the
shortcut menu.

tInfo

w

Add to Cache

f-Mc CheckOut...

otion final

To restore a media asset and move the asset’s primary representation
off the archive device:
= Control-click the archived asset, then choose Restore from the shortcut menu.

The archive icon disappears, indicating that the media asset’s primary representation
has been moved off the archive device. The media asset is available for use.
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Deleting Assets from Final Cut Server

When you delete an asset from Final Cut Server, you delete the asset’s primary
representation file, the proxy files that were created for the asset, and all the metadata
associated with the asset. Because a single asset can be linked to one or more

Final Cut Pro or other project assets, deleting assets should be approached with
caution. You should only delete assets from Final Cut Server if you are certain that the
asset will not be needed.

You can view what project or media assets an asset is related to in the Resources pane
of the asset info window.

—— Other assets that use
the asset are listed in the
Instances list.

Deleting a media or bundle asset and deleting a Final Cut Pro project asset is described
in the steps below.
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To delete a media asset or a bundle asset from the Final Cut Server catalog:
1 Control-click the media asset or bundle asset, then choose Delete from the shortcut menu.

Get Info

Check Out.

Prepare for Disconnected Use

Duplicate

2 In the dialog that appears, click Delete.

The asset is deleted from the Final Cut Server catalog.

To delete a Final Cut Pro project asset from the Final Cut Server catalog:
1 Control-click the asset, then choose Delete from the shortcut menu.

A dialog appears, informing you of which assets and files will be deleted.

2 Read through this message and confirm that you want to delete all of the assets and
files linked with the Final Cut Pro project asset.

3 When you are ready to delete the asset and all of its linked media, click Delete.

The Final Cut Pro asset and all of its linked assets are deleted from the
Final Cut Server catalog.
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Glossary

alias file An alias file is a small file that represents another file. In Final Cut Server, you
can prepare media files to be used later in a new Final Cut Pro project. When you select
one or more media files and choose Prepare for Disconnected Use, alias copies of the
files in the cache are created in the location you choose.

archive Once a project or production is finished, you can use the archive feature to
move the assets from their current device to an archive device, which can be a FireWire
drive, a large slower drive, or another volume where disk space is not an issue. The
assets remain in the Final Cut Server catalog in an inactive state. They can be restored
whenever they are needed later.

asset Final Cut Server creates an asset for every uploaded media or project file. An
asset contains the primary representation file (the file that was uploaded), and can
contain one or more proxy files.

automation Final Cut Server supports a wide variety of automation features, making it
possible to configure Final Cut Server to automatically perform many tasks.

bundle asset In Final Cut Server, you can upload a folder of files as a bundle asset. The
bundle asset contains all of the files in the folder, and the files cannot be accessed from
within Final Cut Server. Bundle assets are used to track Soundtrack Pro, Motion, and
DVD Studio Pro project assets and their linked media files.

cache To use an asset from the Final Cut Server catalog on a client’s computer, the
computer must have a local copy of the asset. Final Cut Server maintains a cache area
on the client computer to store the local copies of the assets. You can define the
location and size of the cache in the client’s Preferences window.

catalog The catalog is the collection of assets that are managed by Final Cut Server.

Glossary
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client The user interacts with the Final Cut Server catalog by using a Final Cut Server
client. Final Cut Server clients are Java-based applications that can run on computers
using Mac OS X, Windows XP, and Windows Vista operating systems.

Clip Proxy At upload, Final Cut Server automatically creates a lower resolution Clip
Proxy file for video assets. The Clip Proxy is used in place of the actual video file when
viewing the asset in Final Cut Server. See proxy.

device Devices are storage locations. They can be folders in a local volume on the
server computer, network volumes, or folders from an Xsan volume.

edit-in-place Generally, in order to use an asset from the Final Cut Server catalog on a
client’s computer, the computer must have a local copy of the asset. An exception is if
the device that contains the asset is configured as an edit-in-place device and the
client computer has it mounted as a volume. The most common example of this is an
Xsan system because they support a high enough data bandwidth for video data to be
transferred in real time. See Xsan.

Edit Proxy At upload, an Edit Proxy file can be created for video files that are uploaded
to Final Cut Server as part of a Final Cut Pro project. Edit Proxy files are intended to be
used when checking out a Final Cut Pro project. Note that Edit Proxy files are not
created automatically; the Final Cut Server administrator must turn on the Edit Proxy
feature to generate Edit Proxy files. See proxy.

element Final Cut Pro project assets contain a list of media assets that are linked to the
Final Cut Pro project file. Final Cut Pro project elements can include media files and
Final Cut Pro sequences.

jobs Any action that Final Cut Server performs on an asset is a job. These actions can
include uploading, downloading, copying, and transcoding an asset.

managed file When you check out an asset, Final Cut Server creates a managed copy
of the file. The managed file can be edited and checked back in to update the original
asset. See unmanaged file.

metadata Metadata is information about a file. In Final Cut Server, metadata is used to
describe the asset’s primary representation file and to describe the asset itself.

metadata set Final Cut Server organizes metadata into metadata sets. Metadata sets
contain groups of metadata; metadata groups contain metadata fields.
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Poster frame A Poster frame is a JPEG proxy file generated from a media asset’s
primary representation file at upload. See proxy.

prepared media In Final Cut Server, you can prepare media files to be used later in a
new Final Cut Pro project. When you select one or more media files and choose Prepare
for Disconnected Use, alias copies of the files in the cache are created in the location
you choose. Later, when your computer is disconnected from Final Cut Server, you can
use the prepared media files to create a new Final Cut Pro project.

primary representation This is the original media file that was uploaded to
Final Cut Server.

production To help organize the assets in your Final Cut Server catalog, you can create
productions. Each production can contain one or more assets. Additionally, an asset
can belong to multiple productions. You might have a production that contains all of
the files for one of your clients, and another that contains only those files from that
client that are used in a specific episode or commercial.

project Many of the applications in Final Cut Studio use project files, which use one or
more linked media files to create a project. Final Cut Server tracks project files with
project assets.

proxy Still images and video files can be very large and difficult to work with.

Final Cut Server automatically creates proxy files during the analyze process when you
add assets to its catalog. These proxy files can be used in place of the actual files for
editing and review purposes. See Clip Proxy, Edit Proxy, Poster frame, Thumbnail.

Thumbnail In the Final Cut Server main window, you can view the assets or
productions in List or Thumbnail view. In Thumbnail view, each asset is represented
with a thumbnail image. This image comes from the asset’s Thumbnail proxy file (a
JPEG proxy file that is generated from a media asset’s primary representation file at
upload). See proxy.

transcode Transcoding converts a media asset from one codec to another. Final Cut Server
uses video and audio codecs supplied by Compressor. See transcode settings.

transcode settings Final Cut Server uses transcode settings to convert a media asset
from its current codec to a different one. Most often you use transcode settings to
convert an asset into one that is smaller or easier to play. The transcode settings for
video and audio assets are from Compressor (which is installed on the server
computer). The transcode settings for images are internal to Final Cut Server.
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unmanaged file When you copy or export a file, Final Cut Server creates an
unmanaged copy of the file. The unmanaged file cannot be edited and checked back in
to update the original asset. If you want to track an unmanaged file in Final Cut Server,
you must upload it and create a new asset. See managed file.

version Final Cut Server can be configured to retain previous versions of selected
assets, making it possible to restore an earlier version if needed. If you check out an
asset from the Final Cut Server catalog, make a change to it, and check it back in,
Final Cut Server first copies the current version to the version device and then copies
the new version to where the current version was.

Xsan An Apple Xsan storage area network (SAN) is a device that provides fast access to
media files. Xsan devices support edit-in-place when you are connected using a Fibre
Channel network. See edit-in-place.

Glossary



Index

Index

A organizing with productions 54-58
Action pop-up menu 53 prepared for disconnected use 107-110
alias files 108, 161 primary representation 32
annotations proxy files 32

about 92-95 removing from production 58

adding 92 restoring 156

deleting 95 status metadata 69

status metadata, applying 144
status metadata, using to search 145
strategies for uploading 31

turning on version control 85

types of 51

uploading 32-36

versions 85-87

replacing text 94
Annotations window 24
AppleCare support 11
Apple websites 10
archiving assets 156
asset info window 21

Action pop-up menu 53

details 79-82 viewing 83

info window 82 Assets pane

Locks pane 81 icons 19

Metadata pane 80, 81, 82 introduction 16
setting views 17

opening 53
Resources pane 80 automations 161
Review & Approve pane 82
Versions pane 81 B
assets bundles
adding annotation 92 and automations 42
adding to cache 104 checking in and out Final Cut Studio projects 130
adding to productions during upload 57 exporting Final Cut Studio projects 155
alias files 108 uploading Final Cut Studio project as 41-45
archiving 156 uploading projects as 41
caching 103-105
catalog overview 49-53 C
changing metadata 71 cache 101
checking in with version comments 86 about 103-105
checking out 86 adding asset 104
deleting from Final Cut Server 158 expired 105
duplicating 96 catalog overview 49-53
exporting 111 checking in and out 105-107
external drive 107 assets 105-107
file extensions 31 Final Cut Pro project 118-122
files that can be uploaded 30 Final Cut Studio project bundles 130
introduction to 29 Final Cut Studio projects as individual files 132-137
locking and unlocking 87-91 client. See Final Cut Server client
metadata 59 clients, about 7
mime type 52 Clip Proxy file 32

165




D

devices
edit-in-place 97
Library 36
Media 36
disconnecting from Final Cut Server
Final Cut Pro projects 124-126
media assets 107-110
Downloads & Uploads window
clearing 98
introduction 25
opening 98
using 98
duplicating an asset 96
DVD Studio Pro projects
about .par files 43
reconnecting media files 135
uploading 40
uploading folder with assets 40

E
edit-in-place 97, 162
caching 103
Final Cut Pro projects, and 117
Edit Proxy files
about 162
checking out Final Cut Pro project 37,118
elements
about 37
Elements pane 38
email, Review and Approve feature 146-151
exporting
final assets and projects 153
Final Cut Pro project and assets 127, 155
Final Cut Studio bundle 155
Final Cut Studio project and assets 156
Final Cut Studio projects 137-139
media assets 111, 154

F
Final Cut Pro
Check In window 122
Check Out window 119
using with Final Cut Server 115-116
Final Cut Pro project info window
about 22, 83
Elements pane 38
Final Cut Pro projects
about 114
checking in 121
checking out 118-122
checking out to a disconnected portable
computer 125
checking out to an external drive 126

Index

creating from assets prepared for disconnected
use 109

deleting from Final Cut Server 159
editing checked out project 120
edit-in-place 117

Edit Proxy files 118

elements 37

exporting 127, 155

issues to know 115

keeping media with project 120, 125
Media Manager, using 121

moving in and out of Final Cut Server 117
resolving offline media issues 116
uploading 37-40

using while disconnected from

Final Cut Server 124-126

versions 117,123

Final Cut Server

catalog overview 49-53
edit-in-place 97

help 9

installing client 15
introduction to 7-8
onscreen user manuals 9
overview of tasks 8
preferences 100-101
printed documentation 9
sleeping computer 32
user interface 15-28
using with Final Cut Pro 115-116
websites 10

workflow 14

Final Cut Server client

actions table 78
installing 15

Final Cut Studio project info window 22
Final Cut Studio projects

about editing 129

checking in and out as bundles 130
checking in and out as individual files 132-137
checking in with linked media files 136
checking out with linked media 132
editing in its original application 134
exporting 137-139

exporting as bundles 155

exporting with assets 156

uploading 40-48

uploading to productions 46

folders

H

uploading as bundles 41
uploading contents as assets 41

help, using onscreen 9



info window
asset 21
Final Cut Pro project 22
Final Cut Studio project 22
production 23

J
jobs
about 74
Jobs in Progress indicator 97
monitoring 97-99
Search All Jobs window 98

K

Keep Media with Project checkbox 125
keyboard shortcuts, about 28

L

Library device 36
Link Upload window 44
List view 18
locking assets 87-91
locks
Checkout 88
locking and unlocking User lock 89-91
Reference 89
User 88

M
managed file 162
Media device 36
Media Manager 121
metadata
changing on assets 71
file and asset 59
introduction 30
status metadata 69, 141-143
status metadata, applying 144
using 58-60
viewing 59
metadata sets
about 60
introduction 30
mime type 52
Motion projects
reconnecting media files 134
uploading 40
uploading folder with assets 40
Multiple Link Upload window 47

Index

Multiple Upload window 34

P

Poster frame 32
Preferences window

alias file location, setting 108
cache preferences 101
introduction 27

opening 100

search preferences 100
using 100-101

prepared media files 163
primary representation 32
production info window 23
productions

adding assets 57

adding assets during upload 57
creating 54

deleting 58

organizing assets 54-58

removing assets 58

status metadata 69

status metadata, applying 144
status metadata, using to search 145
uploading Final Cut Studio projects to 46
viewing 56

Productions pane

icons 19
introduction 17
setting views 17

proxy files 32,163

Q

Clip Proxy 32
Edit Proxy 37
Poster frame 32
Thumbnail 32

QuickTime

R

metadata 35
reference movies 32

restoring assets 156
Review and Approve feature 146-151

administrator-defined and manually entered
reviewers 150

administrator-defined reviewers 148
manually entering reviewers 149

using 147

167



S

Search All Jobs window
introduction 25
using 74-75, 98
Search Devices window
about its contents 72
introduction 26
searching tips 73
using 72-73
searching
advanced 63-65
displaying results 68
introduction 20
preferences 100
result pages 68
simple 61-62
Smart Search 66-67, 146
using Search All Jobs window 74-75
using Search Devices window 72-73
using status metadata 145
servers, about 7
shortcut menus
introduction 28
versions 86
Smart Search
and users 66
creating 66-67
deleting 67
locating Ready for Review items 146
using 67
Soundtrack Pro projects
reconnecting media files 134
uploading 40
uploading folder with assets 40
storage area network (SAN) and caching 103

T
Thumbnails 32

viewing 18
transcode 163

V)

unlocking assets 87-91
unmanaged file 164
uploading

adding assets to production 57

Index

files that can be uploaded 30
Final Cut Pro projects 37-40
Final Cut Studio project as bundle 41-45
Final Cut Studio project as individual assets 45—
48
Final Cut Studio projects 40-48
folders 40
media files 32-36
projects 40
QuickTime reference movies 32
sleeping computer, and 32
strategies 31

Upload window 34

user interface
Annotations window introduction 24
asset icons 19
Downloads & Uploads window introduction 25
info windows 21-23
introduction 15-28
main window 15
Preferences window introduction 27
Search All Jobs window introduction 25
Search Devices window introduction 26
shortcut menu introduction 28

\"

versions 85-87
adding comments 86
disk capacity 85
Final Cut Pro projects 117, 123
reverting 87
shortcut menu options 86
turning on version control for an asset 85
Versions pane 85
viewing assets 83

W

websites 10

working while disconnected from Final Cut Server
Final Cut Pro projects 124-126
media assets 107-110

X

Xsan
caching 103
Final Cut Pro projects 117



	Final Cut Server User Manual
	Contents
	Welcome to Final�Cut�Server
	About Final�Cut�Server
	Resources for Learning About Final�Cut�Server
	Final�Cut�Server Printed Documentation
	Final�Cut�Server Onscreen Manual
	Apple Websites

	Contacting AppleCare Support

	About Final�Cut�Server
	The Final�Cut�Server Client Workflow
	Installing the Final�Cut�Server Client
	The Final�Cut�Server Main Window
	Assets Pane
	Productions Pane

	Views for Assets and Productions Panes
	List View

	Search Options and Saved Searches
	Asset Info Window
	Final�Cut�Pro Project Info Window
	Final�Cut�Studio Project Info Window
	Production Info Window
	Annotations Window
	Downloads & Uploads Window
	Search All Jobs Window
	Search Devices Window
	Preferences Window
	Using Shortcut Menus in Final�Cut�Server
	Using Keyboard Shortcuts in Final�Cut�Server

	Uploading Files to�Final�Cut�Server
	About Creating Final�Cut�Server Assets
	Types of Files That Can Be Uploaded to Final�Cut�Server
	About Metadata and Metadata Sets
	Strategies for Uploading Media and Project Files
	Uploading Media Files
	Uploading Final�Cut�Pro Projects
	Uploading Final�Cut�Studio Projects
	Uploading a Final�Cut�Studio Project and Its Media Files as�a�Bundle�Asset
	Uploading a Final�Cut�Studio Project and Its Media Files as�Individual�Assets


	Organizing and Searching the�Final�Cut�Server Catalog
	An Overview of the Final�Cut�Server Asset Catalog
	Asset Icons
	Types of Assets
	About the Asset Info Window

	Organizing Assets with Productions
	Using Metadata to Organize and Search Assets
	About File and Asset Metadata
	About Metadata Sets

	Searching in Final�Cut�Server
	Doing a Simple Search
	Doing an Advanced Search
	Creating a Smart Search

	Displaying Search Results
	Tracking the Status of an Asset or Production with Metadata
	Adding and Changing Asset Metadata
	Searching Devices and Jobs
	Searching Devices
	Searching for a Job


	Working in Final�Cut�Server
	Final�Cut�Server Client Actions
	About the Asset Info Window
	About Media Asset Info Windows
	About Final�Cut�Pro Project Info Windows

	Viewing an Asset
	Adding Versions for a Media or Project Asset
	Locking and Unlocking an Asset
	User Lock
	Checkout Lock
	Reference Lock
	Locking and Unlocking Assets with a User Lock

	Writing Annotations on a Video Asset
	Duplicating an Asset
	Using the Edit-in-Place Feature
	Monitoring Jobs
	The Jobs in Progress Indicator
	The Downloads & Uploads Window
	The Search All Jobs Window

	Setting Final�Cut�Server Client Preferences
	About Search Preferences
	About Cache Preferences
	About the Saved Aliases for Prepared Media Files Field


	Working with Media Assets
	About Caching
	Checking Out, Editing, and Checking In a Media Asset
	Preparing Media Assets To Be Used on a Computer That�Is�Not�Connected to the Final�Cut�Server Net...
	Exporting Media Assets

	Working with Final�Cut�Pro Projects
	About Final�Cut�Pro Projects
	Using Final�Cut�Pro and Final�Cut�Server Together
	Resolving Offline Media Issues

	Moving Final�Cut�Pro Projects Between Final�Cut�Server and�Final�Cut�Pro
	Checking Out a Final�Cut�Pro Project
	Editing a Checked Out Project in Final�Cut�Pro
	About Using Media Manager with a Checked Out Project

	Checking In a Final�Cut�Pro Project
	Making Versions of Final�Cut�Pro Project Assets
	Working on Final�Cut�Pro Projects While Away from�the�Final�Cut�Server Network
	Exporting a Final�Cut�Pro Project

	Working with Final�Cut�Studio Projects
	About Editing Final�Cut�Studio Project Assets
	Checking Out, Editing, and Checking In Bundle Assets
	Checking Out, Editing, and Checking In Final�Cut�Studio Projects and Their Media Files
	Checking Out a Final�Cut�Studio Project Asset and�Its�Linked�Media�Assets
	Editing a Project File in Its Original Application
	Checking the Project and Its Linked Media Files Back In�to�Final�Cut�Server

	Exporting a Project Asset and Its Media

	Using Status Metadata in�the�Final�Cut�Server Workflow
	Using Status Metadata to Track Assets and Productions
	Applying Status Metadata to an Asset or Production
	Searching for Assets or Productions Using Status Metadata
	Using Smart Searches to Locate Items Ready for Review

	About the Review and Approve Feature
	Using the Review and Approve Feature
	Sending Review Emails to Administrator-Defined Reviewers
	Entering Reviewer Email Addresses Manually
	Using Administrator-Defined Reviewers with Manually Entered Reviewer Email Addresses


	Exporting, Archiving, and Deleting Completed Assets and Projects
	Outputting a Final Project
	Exporting a Media Asset
	Exporting a Final�Cut�Pro Project and Its Linked Media Assets
	Exporting a Final�Cut�Studio Bundle Asset
	Exporting a Final�Cut�Studio Project and Individual Media Assets

	Archiving and Restoring Media Assets
	Deleting Assets from Final�Cut�Server

	Glossary
	Index
	A
	B
	C
	D
	E
	F
	H
	I
	J
	K
	L
	M
	P
	Q
	R
	S
	T
	U
	V
	W
	X



